	Surface Water Ambient Monitoring Program

SWAMP Advisor Training Course Agenda

Date: October 28, 2007   Time: 9:00 AM – 4:00 PM  Location: Room #: UC Davis Extension Sacramento
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	Introductions and Announcements

	
	Presenter:  Dawit Tadesse
	Time:  10 Minutes 

From: 9:00-9:10 A.M

	Purpose:
	Introduction of Training Course Participants

Announcements, if there are any. 



	Desired Outcome:
	 Information exchange
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	Introduction of SWAMP

	
	Presenter:    

Dawit Tadesse
	Time: 15 Min

From:  9:10-9:25 a.m.



	Purpose:
	Introduce the SWAMP program to training participants



	Desired Outcome:
	Familiarity with SWAMP 
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	SWAMP Quality Assurance and QAPPs
	
	

	
	Presenter:    

Will Hagan
	Time: 30 Min; 

From:  9:25 to 9:55 A.M.  

	Purpose:
	Overview of the new SWAMP Quality Assurance Project Plan (QAPrP) and QAPP requirements

	Materials:
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	Advantages and Limitations of Expert Knowledge Systems & the SWAMP Advisor
	
	

	
	presenter:    Larry Keith


	Time:  15 Min; 

From:  9:55 to 10:10 a.m.

	Purpose:
	Introduce SWAMP Advisor

	Desired Outcome:
	Familiarity with SWAMP Advisor

	

	What is the SWAMP Advisor does and how it works

	
	Presenter:    

Larry Keith
	Time:  20 Min; 

From:  10:10 to 10:30 a.m.  



	Purpose:
	Introduce the functionality of SWAMP Advisor

	Materials:
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	  break  15 Min;   10:30 to 10:45 a.m.



	

	How to produce qapp document files

	
	Presenter:  Larry Keith    


	Time:  15 Min; 

From: 10:45 to 11:00 am  

	Purpose:
	Introduce how the SWAMP Advisor produces QAPP document files

	Desired Outcome:
	Understand how to save and name QAPP document files

	

	how to produce tables using swamp advisor

	
	presenter:    

Larry Keith
	Time 15 Min; 

From: 11:00 to 11:15 a.m.  

	Purpose:
	Introduce how the SWAMP Advisor produces comma-delimited tables

	Desired Outcome:
	Understand how to make ‘regular’ tables from comma-delimited data

	how to produce a master qapp document with a table of contents

	
	presenter:    

Larry Keith
	Time 15 Min; 

From: 11:15 to 11:30 a.m. 

	Purpose:
	Introduce how the SWAMP Advisor compiles individual document files

	Desired Outcome:
	Understand how to use Word Macros to make a master QAPP document

	how to incorporate multiple study questions in a qapp

	
	presenter:    

Larry Keith
	Time 30 Min; 

From: 11:30 to 12:00 PM  

	Purpose:
	Introduce the concept of multiple study questions in large complex projects

	Desired Outcome:
	Understand how to integrate data from projects with multiple analytical  levels

	 lunch  60 Min;   12:00 to 1:00 p.m.



	Examples and individual trials using the swamp advisor

	
	presenter:    

Larry Keith
	Time 180 Min; 

From: 1:00 to 3:30 PM  

	Purpose:
	All trainees will complete and produce a QAPP document with the help of the instructor.

	Desired Outcome:
	Trainees trained on how to use the SWAMP Advisor to produce a QAPP

	Discussion and evaluation of the training

	
	presenter:    

All
	Time 30Min; 

From: 3:30 to 4:00 PM  

	Purpose:
	Exchange ideas how to enhance and improve the SWAMP Advisor

	Desired Outcome:
	Ideas will be collected and compiled.


PAGE  
3

_1286175522.doc
Online Resources


Hosted by the State Water Resources Control Board


State Board SWAMP Page:


http://www.waterboards.ca.gov/water_issues/programs/swamp/ 


Launch page to program guidelines, documents, and links

SWAMP Quality Assurance Program Plan:


http://www.waterboards.ca.gov/water_issues/programs/swamp/qapp.shtml

This QAPrP and associated appendices in Adobe PDF and Microsoft Word formats

SWAMP Quality Assurance: 


http://www.waterboards.ca.gov/water_issues/programs/swamp/qapp.shtml 


SWAMP quality assurance homepage and links

SWAMP Email List: 


http://www.waterboards.ca.gov/resources/email_subscriptions/swrcb_subscribe.shtml

Subscriptions to the online mailing lists of various State Board efforts


SWAMP Advisor: 


http://swamp.waterboards.ca.gov/swamp/qapp_advisor/ 


Online tool for SWAMP QAPP creation

Hosted by the Moss Landing Marine Laboratories


SWAMP Standard Operating Procedures:


http://mpsl.mlml.calstate.edu/swsops.htm

SWAMP data management and quality assurance SOPs

SWAMP Quality Assurance Comparability:


http://mpsl.mlml.calstate.edu/swqacompare.htm

Guidelines, links, and a Help Desk pertaining to SWAMP quality assurance comparability


SWAMP Data Management Comparability:


http://mpsl.mlml.calstate.edu/swdbcompare.htm

Guidelines, links, and a Help Desk pertaining to SWAMP data management comparability


SWAMP Information Management System Documentation:


http://mpsl.mlml.calstate.edu/swdbase.htm

Documents pertaining to SWAMP IMS guidelines and training

SWAMP Data Submission Documentation: 


http://mpsl.mlml.calstate.edu/swdataformats.htm

Documents pertaining to SWAMP IMS data submission formats and conventions

Regional SWAMP Report Templates: 


http://mpsl.mlml.calstate.edu/SWAMP_Regional_Report_QA_Section_Template_022908.doc

Narrative and tabular templates for the QA section of regional SWAMP reports

Hosted Externally


Bay, Delta, and Tributaries Project:


http://bdat.ca.gov/Php/ceden

Centralized data sharing network for SWAMP data


EPA Quality System Documents:


http://www.epa.gov/quality/qa_docs.html

Agency-wide Guidance and Requirements documents for internal and external quality systems
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California’s Surface Water Ambient Monitoring Program

SWAMP Advisor Training Course
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Course Introduction

		Dawit Tadesse – Sacramento



		Erick Burres – Riverside







8:40 to 9:00 am
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Housekeeping Information

		Breaks

		Lunch

		Restrooms

		Evaluation Forms
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Course Topics Covered

1. Introduction and SWAMP Objectives - Dawit Tadesse / Erick Burres 

2. SWAMP QA/QC – Will Hagan

3. SWAMP Advisor Introductory Presentations – Larry Keith

	- What an expert knowledge system is and its advantages & limitations

	- Advantages & limitations of the SWAMP Advisor 	

	- What the SWAMP Advisor will do – and how it works

	- Unique and special features of the software

	- How to navigate and how to produce QAPP files and save them

	- How to produce tables of data and format them

	- How to produce a Master QAPP with a Table of Contents

	- How to incorporate multiple study questions in a QAPP



4. Demonstration of the SWAMP Advisor; Hands-on use

5. Questions, Discussion, Evaluation Form Submission

AM

PM

Lunch
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Handout Materials Posted on Internet

		Slides - used for an overview and introduction



		 User’s Manual - refer to it during preparation of your QAPP for step by step instructions or for information on a particular feature .



		 Content Checklist - an overview of the kinds of information needed for each Element in the QAPP is part of the User’s Manual. This information is located in the “Content Checklist” for each Element.



		 Index – Locates where in the Manual a topic is covered.

		 Glossary – Provides 



		 Review Form - use it to provide feedback to us.



		 List any errors found as you use the software.



		 Provide your feedback and recommended improvements.
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Numbered Screen Labels

		 Numbered screen labels are found in the top left hand corner of screens.



		There are left hand side labels and corresponding right hand side labels 



		 These labels are in two different areas of the SWAMP Advisor so be sure to indicate whether your comment involves the left side or the right side of your computer screen.



		 Use these screen labels to report any errors or comments in the Training Course Review Form.



		 That way we can find the error or the portion of the software that you are commenting on.
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SWAMP QA/QC – Will Hagan (Teleconference)

		State Board’s Quality Assurance Document System

		Establishment of Project Objectives

		SWAMP Comparability

		Quality Assurance Project Plan (QAPP) Components



















9:00 to 9:30 am
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Class Participants & Dr. Keith Introduction

		Who is Dr. Lawrence H. Keith and What Does He Know?

		Who are the Class Participants and What Is their Experience and their Objectives?











9:30 to 9:45 am
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The SWAMP Advisor Introduction







Advantages and Limitations 

of 

Expert Knowledge Systems and 

the SWAMP Advisor



9:45 to 10:05 am
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What is an Expert Knowledge System?

		 An “expert system” is an interactive computer program that provides the same answers and advice to questions that a human expert would. 

		It emulates a human expert’s decision-making process in a particular domain of knowledge. 



		 Advantages Include:

		 Ensures that all necessary questions are addressed and all forms needed are available. 



		Advice and information is available at any time day or night 24 hours a day 7 days a week.



		Users quickly find specific information and advice for a particular situation without wasting time on extraneous information.



		Provides consistent advice (unlike humans).
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How an Expert Knowledge System Works

User Follows a Decision Tree Path to the Correct Answer



                                                                  Q1

                                         Yes                                           No

        

                     Q2 A                                                                                     Q2 B



A2 answers                                                                      B2 answers









			 Q3 A                                                                     Q3 B

A3 answers                                                                B3 answers 

                 Yes                                  No

                                                          

Result: Get to right answer rapidly & skip all extraneous information.

A Decision Tree
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Importance of the SWAMP Advisor

		 Many water monitoring projects supported by SWAMP



		 All monitoring projects require a QAPP in consistent format and meeting SWAMP protocols & directives.



		 Users often unfamiliar with Data Quality Objective (DQO) process and some decisions involving Method Quality Objectives (MQOs), method selection, etc. are complex.



		 Electronic QAPP template doesn’t guarantee an acceptable QAPP that will meet SWAMP QAPP requirements.



		 Rejected QAPPs result in wasted staff time and frustrated applicants.
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What the SWAMP Advisor Does

		Leads users through a complex decision-making process.



		Prepares QAPP components step by step – one for each ‘element’.



		Provides advice as well as information.



		 Users write an acceptable QAPP in less time.



		 Doesn’t take the place of a human but simply is a tool to help the human be more efficient and not forget things.



		 Results in more scientifically rigorous QAPPs.



		 Saves SWAMP staff time by eliminating need for revisions.



		 Principal: Do it right the first time every time and save time (and $).
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Complex Relationship of QAPP Components

Budget

MQO s

Method Selection

DQO s

DQI s

QAPP
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SWAMP Advisor Advantages

Advice and information is available for QAPP preparation 24/7.



Allows entry to any QAPP Element at any time to facilitate revising draft QAPP reports.



Draft reports for each QAPP Element are saved on the user’s computer.



Allows multiple lines of inquiry (study questions) and helps users to prepare technical descriptions that are specific to each by looping through applicable questions as many times as needed (i.e., once for each study question) in order to gather all necessary information.



Eliminates the arduous preparation of performance criteria tables in Elements 7, 11, 12, 13, 14, and 16 by automatically “looking up” SWAMP Comparable data based on parameters selected for monitoring and then providing it for all of them at once in a summary report using a “Measurement Core Loop” for each study question.
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SWAMP Advisor Limitations

		 Limitations based on your computer





You must have Java installed (most computers come that way and Java is free and easily installed if you don’t have it.)



Your browser must be set to allow Java to be used with it.



Your computer must allow reports to be sent to it using your browser so pop-up blockers and some firewalls must be disabled so that you can receive your reports.



		 Limitations based on the SWAMP Advisor





Tables are produced in comma delimited format so you must use the “Covert Text to Table” tool to change the text into regular tables.



Once you exit the SWAMP Advisor, all data and information gathered from your session that was not saved in draft reports on your computer is lost (this can be changed if desired next year).
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The SWAMP Advisor Introduction





What the SWAMP Advisor

Does and

How it Works

10:05  to 10:25 am
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Unique Characteristics: (1)  3 Information Planes

The top level "Executive/Emergency Plane" 



		 Gives the user advice and answers for his or her specific needs as quickly as possible. 





The second level "Educational Plane" 



		Provides explanations and ancillary information to help users to understand what is being asked of them, why it is being asked, and what the consequences of their actions may be. 





The third level “Research Plane”



		Reached by internal and external hyperlinks from the second plane - contains extensive in-depth discussions and links to other web sites such as those of US EPA, USGS, etc.  
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Planes of Information Illustrated
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Unique Characteristics: (2)  Dual Screens

		 Has a two panel framework  - Left side and Right side.



		 Expert system questions and advice are displayed in left frame.





		 Explanation, more information and advice accompanies each question  in the right frame - often with links to additional info.
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 Diagram of the Dual Screen Use

Expert System Side

Explanation Side

Has 3 Navigation Buttons

Text with a question at the top.

		  Select Answer #1

		  Select Answer #2

		  Select Answer #3



OK

Back

Restart

Text with more in-depth explanations, examples, and advice. 



                Links to more                    	information.



	Links to Advice



	Links to 	examples to 	copy and paste.



1





Features

1st of 4 - Color Coded Title Bars

		Groups A, B, C, and D each have Top Level Color Coded Title Bars



		 Each Element has a 2nd Level Color Coded Title Bar



		 Each Sub-element has a 3rd Level Color Coded Title Bar



		 Same color for text as 2nd Level Title Bar but with a different background color





1





Features

2nd of 4 – Hyperlinks and “Mouseovers”

		 Hyperlinks to other files and web sites use standard underlined blue type.



		 Links to more pages with additional information and examples.



		Adobe PDF files, 



		PowerPoint slide files, 



		Web pages at other web sites



		 Hyperlinks that are “mouseover” (cursor hover) links are differentiated by using underlined red type.



		 Include acronym definitions, technical word definitions, and comments.
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Features

3rd of 4 – Selected Vocal Explanations

		 Advantage is that sometimes verbal explanations are better and more effective than providing the same information that has to be read.

		 Reduces some explanations that may require lots of text.

		 Disadvantage is that the file must be first loaded by the user’s browser and then a program such as RealPlayer or QuickTime loads and plays the file.

		 User’s computer must have a program that loads and plays music and other sounds

		 Vocal files are large and require 15 seconds or more to load even using broadband or DSL. Dial up would be very slow.
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Features

4th of 4 – Information Entry Methods

 There are 3 ways to enter information:



Computer-written Sentence from Your Selection to a Question -    a pre-formatted sentence into which an answer is inserted to make a complete sentence with all necessary information.



2. Computer-written Sentence from Your Typed Entry to a Question - a pre-formatted sentence into which your typed entry is inserted to make a complete sentence with all necessary information. 



3. User-written Sentence - an entry space for you to write a complete sentence to answer a specific question. 



		This is similar to the entry platform described in #2 except that you type in a complete sentence rather than only a few words.



		You may also copy and paste example answers and edit them as applicable.
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SWAMP Advisor  Navigation

 Navigation in the left side (Expert System) frame



    This is a menu-driven program and throughout it you will be able to navigate among various elements using menus.



	8	When a question is asked with a round “radio button” next 	to the possible selections (for example, like the bullet used 	with this paragraph), then you may select only one of the available choices.



o		When a question is asked with square “check boxes” next to the possible selections (for example, like the bullet used with this paragraph) then you may select more than one choice (even all of them if you wish).



1





SWAMP Advisor  Navigation    (continued)

Navigation in the left side (Expert System) frame



   There are three “navigation bars” in each and every left  side frame. These will appear in all screens of the expert system in the left frame.



		An “OK” bar will advance you to the next question or answer.





		A “Back” bar will return you to the previous screen.





		A “Restart” bar will exit the current use of the program and restart it.
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SWAMP Advisor  Navigation    (continued)

Navigation in the left side (Expert System) frame



		Once you make a menu selection you proceed forward, answering questions with buttons and receiving advice and information from the expert system (left side frame) and the associated Explanation Boxes (screens in right side frame).



 

		You may also go back and change your selections using a “Back” bar. 
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A Break is Next





Questions?
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The SWAMP Advisor Introduction



Break!



10:25 am to 10:45 am
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The SWAMP Advisor Introduction

How to Produce

QAPP

Document Files



10:45 am to 11:00 am
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How QAPPs Are Developed –

Saving Files

At the end of working with each of the QAPP “Elements” (sections) you are asked if you want to save your work.



If you select “Yes” the SWAMP Advisor prepares a draft document with your answers in a Rich Text Format (RTF).



This RTF document is sent to your computer and you save it to a folder where your QAPP files reside.
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How QAPPs Are Developed –

Naming Files

		You MUST name the file correctly in order for a MS Word Macro to find it and append it into a Master QAPP document.



		Files are named using the “Element” number and “-QAPP.rtf”



		 For example, the file for Element 6 must be named  “6-QAPP.rtf”



		 For example, the file for element 12 must be named “12-QAPP.rtf”



		 For example, the combined Elements 15, 16, & 17 file must be named “151617-QAPP.rtf”



		The extension name “.rtf” must be in lower case.
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   These are the Correct File Names

		1-QAPP.rtf		9-QAPP.rtf		18-QAPP.rtf

		3-QAPP.rtf		10-QAPP.rtf		19-QAPP.rtf

		4-QAPP.rtf		11-QAPP.rtf		20-QAPP.rtf

		5-QAPP.rtf		12-QAPP.rtf		21-QAPP.rtf

		6-QAPP.rtf		13-QAPP.rtf		22-QAPP.rtf

		7-QAPP.rtf		14-QAPP.rtf		23-QAPP.rtf

		9-QAPP.rtf		151617-QAPP.rtf		24-QAPP.rtf
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Document File Demonstration





Element 14 will be used 

to demonstrate 

preparation, naming, and saving 

of a typical QAPP file.
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The SWAMP Advisor Introduction





How to Produce

Tables



11:00 am to 11:15 am
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Advisor Table Formats

		The SWAMP Advisor produces tables in a comma-delimited format.



		Here is an example of a 4 column comma-delimited format:





		Analyte, Method Type/Principle, Detection Limit, Precision

		Arsenic, Flame Atomic Absorption, 100 ug/L, 20%

		Cadmium, ICP-Atomic Emission, 1 ug/L, 10%

		Lead, Graphite Furnace Atomic Absorption, 60 ug/L, 15%				
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Table Conversion  Procedure

Highlight the comma-delimited data (including column headings)

On the toolbar menu click on “Table”

In the Table Menu click on “Convert”

In the Convert options click on “Text to Table”

Below is the instant result:



		Analyte		Method Type/Principle		Detection Limit		Precision

		Arsenic		Flame Atomic Absorption		100 ug/L		20%


		Cadmium		ICP-Atomic Emission		1 ug/L		10%

		Lead		Graphite Furnace Atomic Absorption		60 ug/L		15%
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Table Preparation Demonstration



Element 3 (Distribution List )

 will be used 

to demonstrate

Table Preparation
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The SWAMP Advisor Introduction





How to Produce

A 

Master QAPP Document



11:15 am to 11:35 am
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How QAPPs Are Developed –

Preparing a Master QAPP

		Your QAPP folder will contain 21 files all ending in “-QAPP.rtf”



		After all files are present then you download the Cover Page.





Download link is in the right side panel of the SWAMP Advisor opening page and also in the last right side panel of the last “element” (Element 24).



Save the cover page to your QAPP folder. It has a Macro that will automatically find and append each of the 21 files in the correct order and then to automatically prepare the table of contents. 



Go to the bottom of the page and press the “Alt” and letter “a” keys (Alt + A) to activate the Macro.

Complete all final edits and formatting (including            changing comma-delimited tables into regular table         format), rename and save the file, and print it.
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QAPP Preparation Demonstration





A pre-prepared set of files

will be used 

to demonstrate

Master QAPP Preparation
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The SWAMP Advisor Introduction







How to Incorporate

Multiple

Study Questions



11:35 am to 12:00 pm
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Planning Monitoring Activities

		 Often, a project may have more than one line of inquiry (or study question).



		 Examples include:



		Source identification – where do the analyte(s) of interest come from?



		Ambient water quality – does the quality of the water support its intended uses (recreation, drinking, etc.).



		 Different study questions usually require different sampling strategies, different measuring techniques, different Measurement Quality Objectives (MQOs),        etc.
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Measurement Core Loop Concept

		 The problem:



		How to handle different sampling  and analytical strategies and needs for different study questions.



		 The Solution:



		Devise a mechanism so that a user can provide answers that are unique for each study question.



		This mechanism is a “loop” through the same questions multiple times – there is no limit to the number of study questions and associated “loops.”



		 Enables users to obtain appropriate data for multiple study questions.



		One caveat is that each “loop” generates a separate    document and each document file must be given a            unique name.
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The 5-Step Measurement Core Loop Process (Steps 1-3)



Develop study question(s) the project will answer



Identify what will be measured to answer each study question and how it will be measured

		Identify the parameters (what) and procedures/instruments (how)

		This process is repeated for each study question





Select quality objectives to answer each study question

		For example: reporting limits, precision, accuracy
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The 5-Step Measurement Core Loop Process (Steps 4 & 5)





Select measurement systems that will achieve the defined quality objectives



		Measurement systems are devices and/or procedures used for measuring environmental characteristics



		For example: instruments used for field measurements, sampling and analysis procedures





Define requirements for the types and frequency of quality checks and identify the acceptance criteria for their outcomes



		Tip: Use the SWAMP Quality Assurance            Management Plan to help define the quality objectives





1



*









The 5-Step Measurement Core Loop Process Flowchart



Repeat this loop

for each study

question in the 

Quality Assurance 

Project Plan

Develop study question

Specify what to measure (parameter) and how (procedure/instrument)

Select quality objectives

Identify measurement system

Define quality checks and acceptance criteria
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Monitoring Plans vs QAPP

Monitoring Plans – Sample Design Planning



		Focus on operations, contain high level of details, and are used daily by Project Operators (data gatherers).  



		Follow the planning thought process.



		Provide rationale for selecting locations and timing to monitor.





QAPP Documents – Measurement Planning



		The SWAMP Advisor is built to accommodate this thought process in the Sampling Design Loop (Element 10).





Monitoring Plans are Usually Developed First





		The SWAMP Advisor does not yet support Monitoring Plans         but it is a logical extension.



		 A “cart before the horse” example.
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The Sampling Design Process

Element 10 Covers the Sampling Design Process



Formulate a specific study question.

Communicate the spatial (station selection) intent: why measure at that spot? 

Communicate the temporal (timing selection) intent: why measure at this particular time?  

Define the sampling design principle used to select location (at two spatial scales – reach and station).

Define the sampling design principle used to select timing (at two temporal scales: seasonal and diurnal).
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Demonstrate the Measurement Core Loop





The Measurement Core Loop

will be demonstrated 

using Element 10
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The SWAMP Advisor Introduction

Lunch!



12:00 pm to 1:25 pm
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Hands-on Trials With Instruction As Needed

		Element 1 & 2 – Title & Approval and Table of Contents

		Element 3 – Distribution List (Table Preparation)

		Element 6 – Project / Task Description (New Bioassays)

		Element 7 – Quality Objectives for Criteria & Measurement Data (Generate Multiple Tables Simultaneously)

		Element 12 – Sample Handling

		Element 13 – Analytical Methods

		Element 14 – Quality Control

		Elements 15, 16, 17 – Testing, Calibration, and Supplies

		Element 19 – Data Management

		Element 24 – Reconciliation with User Requirements

		Optional Element 10 – Sampling Process Design (if time permits)





1:25 pm to 4:00 pm
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Discussion and Training Evaluation







Questions?



Be sure to fill out the Evaluation Form.



Help us to Make the SWAMP Advisor Better!



4:00 pm to 4:30 pm
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SWAI

SWAMP Advisor

The California Surface Water Ambient Monitoring Program’s (SWAMP) expert

system for preparing Quality Assurance Project Plans (QAPPs) correctly,
consistently, and cost-effectively.

509 000 00

Group A Elements: Project Management
Element 6 - Project/Task Description
Section 6.1 - Work Statement and Produced Products
6.1.3 - Standard Reparts. Please select the types of standard reports that will

be generated by your project. Next, other types of reparts wil be addressed.
*Monthly Reports plus a Final Report

Monthly and Quarterly Reports plus a Final Report

Monthly and Semi-annual Reports plus a Final Report

Quarterly Reports plus a Final Report
Quarterly and Semi-annual Reports plus a Final Report

Semi-annual Reports plus a Final Report
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ISBN 1-885844-13-1
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added to a draft work statement that

describes the standard reports.
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1.0 Problems and Solutions


The SWAMP Advisor expert knowledge system contains comprehensive information and advice for preparing Quality Assurance Project Plans (QAPPs) that will meet all of California’s Surface Water Ambient Monitoring Program’s (SWAMP) criteria. It uses Java XE "Java"  “applets XE "applets" ” with your computer’s browser XE "browser"  and information that “pops up” in your browser. Therefore, your browser must be configured to accept “pop ups XE "pop ups" ” and Java programming (which is free) must be installed on your computer. Most common problems are solved by employing solutions to these two requirements as described below.


1.1 The Left Side of My Screen Appears Blank


Solution XE "Solution" : Allow Java XE "Java"  Applets to Function in Your Browser or Add Java if it is Not Available.


If you do not see the opening text and menu of the expert system XE "expert system"  in the left panel then your browser XE "browser"  is not loading applets XE "applets" . These are under the control of your browser and you will either need to load JAVA software or configure your browser to accept applets if you already have Java XE "Java" . Follow the steps below:


1. Go to "Tools" in your browser XE "browser"  menu. 


2. Select "Internet Options XE "Internet Options" " and when that menu comes up select the "Security XE "Security" " tab. 


3. Select the "Custom Level XE "Custom Level" " button under your browser XE "browser"  security tab. 


4. Scroll down the various options until you reach "Microsoft VM XE "Microsoft VM" " and under that will be a heading "Java XE "Java"  permissions." If "Disable Java" is selected then the following error message XE "error message"  will appear in the left panel of your monitor: "The expert system XE "expert system"  would be running here but your browser XE "browser"  has Java Applets disabled or does not support Java Applets." If this is the case, then click on "Medium Safety" under "Java permissions." If you make a change to your browser be sure to then click on the "OK" button to activate the change. 


5. Next, scroll further down the Custom Level XE "Custom Level"  until, near the bottom, you reach "Scripting of Java XE "Java"  applets XE "applets" ". Make sure that this option is checked "Enable." If it is not, then change the setting to "Enable." If you make a change to your browser XE "browser"  be sure to then click on the "OK" button to activate the change. 


6. After completing any changes necessary to the "Security XE "Security"  - Custom" settings then select the "Advanced" tab in the Tools main menu. Scroll half way down this list of options until you come to those marked "Microsoft VM XE "Microsoft VM" " and place a check in all three options: "Java XE "Java"  console enabled (requires restart), Java logging enabled, and JIT compiler for virtual machines enabled (requires restart)." Then you must click on the "OK" button to activate the change. 


7. After making changes to your browser XE "browser"  Tools, close any programs you have running and restart your computer. You should check the Tools changes that you just made to make certain that the changes you intended to make were indeed made. After verifying these changes you should be ready to retry the Internet link to the expert system XE "expert system" . 


8. If the above checks did not result in the applets XE "applets"  loading in your browser XE "browser"  then you may need to update your JAVA program. Here is how you do that: 


Uninstall XE "Uninstall"  the old Java XE "Java"  program. Depending on your install, there may be more than one program to uninstall. For example you may have to uninstall the Java Runtime XE "Java Runtime"  and the Java SDK XE "Java SDK" . If you have the Java SDK, do not uninstall anything until you check with your system administrator. You uninstall programs by going to "Control Panel XE "Control Panel" " on your computer and selecting "Add or Remove Programs." If Java is present you should see it listed in alphabetical order. If it is not present then, of course, you can't uninstall it. 


Next, go to http://java.com/ 


On the right hand side is an orange button labeled 'Java XE "Java"  Software Download'. Select it. This brings you to a second screen with an orange bar that says "Begin Download" and this will be an automatic download. 


You do NOT have to purchase Java XE "Java"  on a CD. Instead, look for the online download. Make sure you get the one for your operating system - but that could be automatically selected if you use the automatic install XE "automatic install" . The automatic install will download and install everything automatically. The manual install XE "manual install"  requires you to perform the install after you have performed the download. When it asks if you want the Plug-In, be sure to checkmark the box next to Internet Explorer (IE). 


If you are using a browser XE "browser"  other than Microsoft Explorer 6.0 XE "Microsoft Explorer 6.0"  then you should make similar checks and changes to the appropriate tools that involve applets XE "applets"  in whatever browser you are using. 


1.2 Competed Reports Do Not Appear in My Browser


Solution XE "Solution" : Deactivate Your Browser’s Pop Up Blocker XE "Pop Up Blocker" 

If you have Pop Up Blocker XE "Pop Up Blocker"  software installed (from commercial sources such as Earthlink, AOL, etc.) you will need to access that software's instructions to deactivate it. This is to enable the SWAMP server to send text reports for your QAPP to your computer.  


However, if your browser XE "browser"  deactivates pop ups XE "pop ups"  automatically then follow these steps:


1. Go to "Tools" in your browser XE "browser"  menu. 


2. Select "Internet Options XE "Internet Options" " and when that menu comes up select the "Security XE "Security" " tab. 


3. Select the "Custom Level XE "Custom Level" " button under your browser XE "browser"  security tab. 


4. Scroll down to the option involving pop up blocking XE "pop up blocking"  and check the option that will allow pop ups XE "pop ups" . This usually involves one or both of the following: 


1 To turn off the Information Bar XE "Information Bar"  for file downloads XE "file downloads" , in the Downloads XE "Downloads"  section of the list, under Automatic prompting XE "Automatic prompting"  for file downloads, click Enable. 


2 To turn off the Information Bar XE "Information Bar"  for ActiveX controls, in the ActiveX controls and plug-ins section of the list, under Automatic prompting XE "Automatic prompting"  for ActiveX controls, click Enable. 


1.3 Completed Reports Appear for a Second and Then Disappear


Solution XE "Solution" : Enable Downloads XE "Enable Downloads"  in Your Browser.


If you select the Save to Print XE "Save to Print"  option in the SWAMP Advisor and you see that a file apparently pops up and then immediately disappears before you can do anything about it then you probably have one of the "Download" options in the security settings of your browser XE "browser"  checked as 'disable.' 


To check and correct this problem please follow these steps: 


1. Go to "Tools" in your browser XE "browser"  menu. 


2. Select "Internet Options XE "Internet Options" " and when that menu comes up select the "Security XE "Security" " tab. 


3. Select the "Custom Level XE "Custom Level" " button under your browser XE "browser"  security tab. 


4. Scroll down the various options until you reach the menu item for "Downloads XE "Downloads" ." There are usually three sub menu items and all of them should be checked "Enable." 


1.4 Completed Reports Can Not Be Viewed Until Saved


Solution XE "Solution" : Save the Report to Disk or Use a Different Browser than IE 7 XE "IE 7" .


Microsoft’s Internet Explorer Version 7 XE "Internet Explorer Version 7"  (IE 7 XE "IE 7" ) currently causes this problem. 


Heightened security in IE 7 XE "IE 7"  doesn’t allow documents sent from the California computer server to be viewed without first saving them. When a report is sent to your browser XE "browser"  you should see three choices: "Find" "Save" and "Cancel." 


Your only useful option is to select "Save" and then give your file a name with the extension of RTF XE "RTF"  on the end (for example: 7-QAPP.rtf or 14-QAPP.rtf, etc.). You are going to save your draft file anyway so this is a small inconvenience in that IE 7 XE "IE 7"  does not let you first view your file (and perhaps edit it if you wish) before you save it. 


1.5 SWAMP Advisor Does Not Fit My Monitor’s Screen Size (Too Big or Little)


Solution XE "Solution" : Modify your Computer’s Monitor Resolution XE "Monitor Resolution" 

The SWAMP Advisor is best viewed using a monitor where your screen resolution XE "screen resolution"  is set to 1024 x 768 pixels. This is because there are two frames XE "frames"  and they should occupy your entire monitor's screen at the specified resolution in order to avoid excess scrolling. If you have a lower resolution you will have to do a lot of scrolling to read all of the information that is presented to you. Even with the recommended resolution you will sometimes need to scroll but this is kept to a minimum. 


You can easily change your screen resolution XE "screen resolution"  if you determine that this is a problem. And it is just as easily changed back to your initial resolution, should you want that, after you have finished using the software. The change should take you less than a minute to perform by following the instructions below:


1. Go to your Control Panel XE "Control Panel"  (often linked under My Computer or under Start). 


2. Click on Display Properties. 


3. Click on the Settings Tab XE "Settings Tab"  in the Display Properties dialog box. 


4. Set the Screen Resolution to 1024 x 768 pixels (either by sliding the bar or clicking on the right side of the Screen Resolution indicator). 


5. Click on “Apply” or on “Okay” and the new screen resolution XE "screen resolution"  will be applied. You may get a message asking you to confirm that you want to change the screen resolution and, if so, click on “Yes”. 


1.6 CoverPage.doc XE "CoverPage.doc"  Does Not Start Appending


Solution XE "Solution" : Re-save the file to the folder where your QAPP files reside.


The CoverPage.doc XE "CoverPage.doc"  file that you download from the California server when you are ready to prepare a Master QAPP XE "Master QAPP"  document has a ‘macro XE "macro" ’ that automatically finds and appends all of the 21 individual document files XE "document files"  from the SWAMP Advisor that you have saved. However, sometimes when you shut down your computer and then restart it and activate the CoverPage.doc file then the macro doesn’t find the files that it is supposed to append.


If this happens then re-save the file CoverPage.doc XE "CoverPage.doc"  being careful to make sure that it is re-saved to the folder where all of your individual QAPP document files XE "document files"  are saved. This simple operation should then enable the macro XE "macro"  to correctly function and automatically append all of the document files to make your Master QAPP XE "Master QAPP"  file.


1.7 CoverPage.doc XE "CoverPage.doc"  Stops Appending Before Finishing


Solution XE "Solution" : Rename the Missing File or Find and Save It.


If the CoverPage.doc XE "CoverPage.doc"  file starts to append your individual QAPP files XE "individual QAPP files"  to make a Master QAPP XE "Master QAPP"  file and suddenly stops and displays an error message XE "error message"  then it can’t find a file that is needed to complete the Master QAPP document XE "Master QAPP document" .

The error message XE "error message"  that will pop up on your screen displays:



“Run-time error XE "Run-time error"  ‘5174’:



This file could not be found.



(Missing Filename appears in parenthesis at the bottom of the message)


A missing file XE "missing file"  may be caused either because it is not present in the folder where you saved the file CoverPage.doc XE "CoverPage.doc"  or because it has been named incorrectly. Incorrect file names are usually the result of a typing error during the saving of the fie or, perhaps, the last three letters are in caps (i.e., x-QAPP.RTF XE "RTF"  instead of x-QAPP.rtf).


In any event, the error is usually able to be quickly found and corrected because the error message XE "error message"  shows you which file name is causing the problem.


2.0 Background – Expert Systems and the SWAMP Advisor


Expert knowledge systems are computer programs will give a human expert’s advice with a particular topic. Thus, they emulate a human expert’s decision-making process in a particular domain of knowledge.  Thousands of expert knowledge systems XE "expert knowledge systems"  have been developed around the world for assistance over a wide range of topics and subjects. Expert systems XE "Expert systems"  often have dual uses as they assist in the training XE "training"  of individuals in a particular subject, and they also offer fast, effective on-the-spot advice in the form of easy to answer questions. 


Writing Quality Assurance Project Plans (QAPPs) for environmental monitoring projects requires highly technical training XE "training"  and specialized knowledge. For example, monitoring projects may require knowledge that involves:


1 Sampling XE "Sampling"  – determining whether to collect representative samples XE "representative samples"  or judgmental samples XE "judgmental samples"  (perhaps reflecting “worst” or “best” conditions at a site and knowing that the answer depends on the question(s) that the project is designed to answer.


2 Sample Containers XE "Sample Containers"  – correctly selecting the right container(s) for different types of contaminants (organic, inorganic, volatile compounds, compounds sensitive to light, etc.) each of which require different kinds of containers XE "containers"  (glass, plastic, etc.).


3 Sample Preparation XE "Sample Preparation"  – knowing how to correctly preserve samples XE "preserve samples" , if necessary. When to preserve samples and when not to? How to correctly store samples XE "store samples"  and how long can they be stored?


4 Analytical Methods XE "Analytical Methods"  – answering questions such as how sensitive, how precise, how selective (detecting a specific analyte or class in the presence of others perhaps at higher concentrations), and how good does the analyte recovery XE "analyte recovery"  need to be?


5 Quality Control Samples XE "Quality Control Samples"  – determining which quality control XE "quality control"  (QC) samples will be necessary to provide answers on the quality of the data that will be collected. For example, are QC samples XE "QC samples"  necessary to differentiate between sample contamination XE "contamination" , and procedural errors XE "procedural errors" , to calculate confidence levels XE "confidence levels"  for DQOs XE "DQOs" , to measure bias XE "bias"  from incomplete recovery XE "recovery" , to measure imprecision XE "imprecision" , etc.


 The above are some of the many interrelated components of QAPPs that directly or indirectly affect each other. These are illustrated in Figure 2.1.
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Figure 2.1 - Relationships of Key Components of a Typical QAPP


The purpose of the SWAMP Advisor is to help users to write QAPPs in a shorter amount of time and that will be acceptable the first time they are submitted for review. In addition, another objective is to teach users why they are being requested to provide certain information as well as being instructed how best to provide it.


Using the SWAMP Advisor to help write QAPPs will result in more scientifically rigorous documents that will save Water Board staff time because they will be done correctly the first time and not have to be rewritten and then reviewed again. Also, by causing the users to think about why they are doing certain things (such as selecting analytical methods) better alternatives may result instead of simply proposing doing the analyses XE "analyses"  by rote and using the same methods that may have been used in the past with no other considerations.


3.0 SWAMP Advisor Navigation and Use


In this section the important features that relate to the quick and easy navigation XE "navigation"  of the expert system XE "expert system"  are summarized.


3.1 SWAMP Advisor Layout


When you start the SWAMP Advisor you will see a screen with two “frames XE "frames" ,” as in Figure 3.1 below. The expert system XE "expert system"  (which asks questions and provides answers and advice) is in the left hand frame. In the frame on the right side is an “Explanation Screen XE "Explanation Screen" ” in which additional information is provided. This additional information may include information about the question being asked or it may provide links XE "links"  to additional pages of information, reports, figures and tables, and even other web sites. The explanation screens automatically change depending on the content in the left hand side frame.
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Figure 3.1 – SWAMP Advisor Dual Screen Diagram


Click the bar labeled “Yes, I’m ready to enter the SWAMP Advisor” to start the program. The first question asked is which Group of Elements you wish to work with. There are 24 “Elements” (or “sections”) to be completed in order to have a SWAMP-Comparable XE "SWAMP-Comparable"  QAPP and these are organized into three major groups:


1 Group A Elements XE "Group A Elements"  (Numbers 1 – 9) involve ‘administrative functions XE "administrative functions" ’


2 Group B Elements XE "Group B Elements"  (Numbers 10 – 19) involve data generation and acquisition XE "data generation and acquisition" .

3 Group C & D Elements XE "Group C & D Elements"  (Numbers 20 – 24) involve data assessment XE "data assessment" .

These element groupings and topics follow U.S. EPA’s format. Note, however, that the SWAMP Advisor combines questions involving Elements 15, 16, and 17 XE "Elements 15, 16, and 17"  into one menu selection. This is because of the interrelated nature of the questions and the information being gathered. However, your answers are correctly placed in the individual sections of the QAPP document where they reside (i.e., Sections 15, 16, and 17 respectively).


Also be advised that the SWAMP Advisor automatically produces comma-delimited XE "comma-delimited"  tables for Elements 12, 13, 14 and 16 at the same time that it produces tables 7.1 and 7.2 in Element 7 XE "Element 7" . This is because the data that is provided from SWAMP QAMP documents for the analytes XE "analytes"  that you select is also used in these other element documents. Since some users may not always complete these other element documents during the same session that the Element 7 document is produced, these extra tables are generated at the end of the document file for Element 7. The disadvantage is that you must then copy and paste them into their respective element documents (where there are notes to remind you where the appropriate tables go). However, the advantage is that you do not have to answer the same questions over and over again for each of the other elements in order to have the SWAMP Advisor automatically find the appropriate data and generate the tables that you need.


3.2 SWAMP Advisor Navigation


The SWAMP Advisor is a menu-driven program and throughout it you will be able to navigate among various elements using menu selections. There are two types of buttons:


1 When a question is asked with a round “radio button XE "radio button" ” next to the possible selections (for example, like the bullet used with this paragraph), then you may select only one of the available choices.


When a question is asked with square “check boxes XE "check boxes" ” next to the possible selections (for example, like the illustration used with this paragraph) then you may select more than one choice (even all of them if you wish).


Note also that there are three “navigation XE "navigation"  bars” in each and every left  side frame. These will appear in all screens of the expert system XE "expert system"  in the left frame.


1 The “OK” button will advance you to the next question or answer.


2 The “Back” button will return you to the previous screen.


3 The “Restart” button will exit the current use of the program and restart it.


Once you make a menu selection you proceed forward, answering questions with buttons and receiving advice and information from the expert system XE "expert system"  (left side frame) and the associated Explanation Screens XE "Explanation Screens"  (those in the right side frame). You may also go back and change your selections using the “Back” button at any time.


3.3 Color Coded Title Bars XE "Color Coded Title Bars" 

As you progress through various elements and sub-elements you realize that developing a QAPP is a complex process with many different levels. In order to help users keep perspective of where they are in the process, Color Coded Title Bars XE "Color Coded Title Bars"  have been added to each question asked. These are illustrated in Figure 3.2.
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Figure 3.2 - Illustration of Title Bars in the Left Frame Questions.


The top title XE "title"  bar shows the “Group” in which you are working. Groups A, B, C, and D each have “Top Level” title bars XE "title bars" .


Each “Element” has a color coded title XE "title"  bar – these are the second level bars directly under the top level title bar.


When there are “Sub-elements” (for example, Element 6 XE "Element 6" .1, 6.2, 6.3, etc.) these appear as third level bars directly under the relevant second level “Element” title XE "title"  bar. Furthermore, although different background colors are used to highlight XE "highlight"  differences between the third and second level bars, the same text color is used in the third level bar and its associated second level Element Title to emphasize their relationships to each other.


3.4 Multiple Planes of Information


The SWAMP Advisor is developed using the concept of multiple planes of information XE "multiple planes of information" . These are illustrated in Figure 3.3.
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Figure 3.3 - Three Planes of Information in the SWAMP Advisor

At the highest level (“Executive Plane XE "Executive Plane" ”) you can cruse through the questions and receive rapid short answers and advice.


More information is provided at the second level (the “Educational Plane XE "Educational Plane" ”) which is always located in the “Explanation Screen XE "Explanation Screen" ” in the right frame. Educational information XE "Educational information"  usually focuses on the “What, Where, When, Why, and How” aspects of a given question or answer.


A third level, reached from links XE "links"  through either the left or right frame is called the “Research Plane XE "Research Plane" ” and it typically contains reports, documents (for example, table formats or slides) and links to other Internet sites (for example, EPA or California web sites).


“Pop-up” definitions and comments are also provided for selected acronyms XE "acronyms"  and technical words used in the Explanation Screen XE "Explanation Screen" . These are always formatted using red underlined type XE "red underlined type"  to distinguish them from the usual links XE "links"  (formatted in blue underlined type) to other information, documents, or web sites. These designations are emphasized in the very first Explanation Screen that appears when the SWAMP Advisor is booted up.


4.0 Preparing Your Final QAPP


The SWAMP Advisor has a cover page file named “CoverPage.doc XE "CoverPage.doc" ” that you may download from either the opening page right side screen or one of the final screens in Element 24 XE "Element 24" . If you have prepared, saved, and correctly named each of the document files XE "document files"  from all of the elements in the SWAMP Advisor then this file will automatically append all of them in the correct order for a Master QAPP XE "Master QAPP"  document.


4.1 Numbering QAPP Files


The SWAMP Advisor sends document files XE "document files"  to your computer’s browser XE "browser"  in “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ). In order to easily manage the text of each file they should be named in an easily remembered and consistent format. And, since the macro XE "macro"  in the “CoverPage.doc XE "CoverPage.doc" ” file searches for and appends files in the correct sequence, they must be named correctly. Each file is named using the Element number followed by “-QAPP.rtf” for consistency.


For example, the filename for Element 3 XE "Element 3"  is, “3-QAPP.rtf” and that for Element 4 XE "Element 4"  is, “4-QAPP.rtf”. 


Table 4.1 - Correct Naming Format for All Element QAPP Files


		1-QAPP.rtf

		9-QAPP.rtf

		18-QAPP.rtf



		3-QAPP.rtf

		10-QAPP.rtf

		19-QAPP.rtf



		4-QAPP.rtf

		11-QAPP.rtf

		20-QAPP.rtf



		5-QAPP.rtf

		12-QAPP.rtf

		21-QAPP.rtf



		6-QAPP.rtf

		13-QAPP.rtf

		22-QAPP.rtf



		7-QAPP.rtf

		14-QAPP.rtf

		23-QAPP.rtf



		8-QAPP.rtf

		151617-QAPP.rtf

		24-QAPP.rtf





There are only two exceptions as shown above in Table 4.1:


1. There is no file for Element 2 XE "Element 2" , Table of Contents XE "Table of Contents" . The heading “2.0 Table of Contents” is at the bottom of the  Element 1 XE "Element 1"  document file because there are no questions associated with the Table of Contents – it is simply an automatic procedure.


2.  The SWAMP Advisor combines questions involving Elements 15, 16, and 17 XE "Elements 15, 16, and 17"  into one menu selection (see Section 3.1) because of the interrelated nature of the questions and the information being gathered. Therefore, this file is named, “151617-QAPP.rtf.


4.2 Previewing Draft Text


As you go through each element, those in which the SWAMP Advisor develops key text from your input will automatically be presented to you with a preview XE "preview"  of the draft product. In some cases this will be shown to you at the end of your work with an element and in other cases, where elements are more complex and contain sub-elements, a preview of the sub-element XE "sub-element"  you just finished will be shown to you. An example of this latter situation is with a preview of your answers with the Bioassay Section XE "Bioassay Section"  questions of Element 6 XE "Element 6" , Section 1.


In previewing the draft text please note that this format is not as flexible as the text formats in the QAPP document files XE "document files" . Therefore, you may sometimes note extra text headings that is not relevant to your answers – this will not appear in your QAPP document files. In the future the preview XE "preview"  format may be changed to reflect the “What you see is what you get” concept but, for now, the current preview format is less expensive.


After reviewing the draft text if you want to change any of your answers then simply use the “back” button to go back to the question where the change is to be made, change your answer and then go back to the end again. 


Going back to the end of a section again can be quite fast because all you have to do is click on the “OK” button – if you didn’t change anything then you’ll see that your previous answer is still present in the system and you simply go on back to the end.


Again your draft text will be presented for review and you should note the change in it that your revision(s) to the question(s) resulted in.


4.3 Saving Draft Text for Printing and Appending to the QAPP


After you have reviewed and accepted the draft text, as explained above, you will be asked if you wish to save it in a Rich Text Format XE "Rich Text Format"  (RTF XE "RTF" ). If you select “No.” then you will simply go on to the next question. 


If you select “Yes” then the QAPP document file will be sent to your browser XE "browser"  for review and/or saving. This file will open in a new window in your browser.


You MUST rename this file and save it to your computer. You may save it to a hard drive or a floppy diskette, or even a read-write CD-ROM – it is your choice. 


HINT:  it is best to start a new folder with the name of your QAPP or project prior to saving any files. If you save your files to a floppy diskette then this probably isn’t necessary, assuming that you have no other files on the diskette.


Because you will be appending each saved file to your Master QAPP XE "Master QAPP"  in numerical order by Element Number and using a macro XE "macro" , you must name each file correctly. The correct format for file names is provided in Section 4.1 and all file names are listed in Table 1.


Follow the directions below:


1. Click on “File” in the Toolbar of the RTF XE "RTF"  document.



2. Choose the “Save As” option.


3. At the bottom of the “Save As” dialog box is a selection identified as “Save As    Type” with a drop down menu of choices.  Select the choice “Rich Text Format XE "Rich Text Format"  (*.rtf)” by clicking on that selection. 


4. Type in the new file name using the Element Number and “-QAPP.” You also include the path in the name if it is not already present and correct.


For example, if you are saving to a floppy diskette (typically Drive A) then the path for Element 6 XE "Element 6" , Section 4 would typically be: 


A:/6-QAPP.rtf

If you were saving it to a folder named MyProjectQAPP on your hard drive C:, then the path and name would be:



C:/MyProjectQAPP/6-QAPP.rtf

4.4 Reformatting Tables in Saved Text Files


All tables in Rich Text Format XE "Rich Text Format"  files are in a “comma-delimited XE "comma-delimited" ” format. An example is shown below:




Analyte, Method Type/Principle, Detection Limit, Precision




Arsenic, Flame Atomic Absorption, 100 ug/L, 20%




Cadmium, ICP-Atomic Emission, 1 ug/L, 10%




Lead, Graphite Furnace Atomic Absorption, 60 ug/L, 15%


To convert XE "convert"  a comma-delimited XE "comma-delimited"  format to a regular table format XE "regular table format"  follow these instructions:


1. Highlight the comma-delimited XE "comma-delimited"  data (including column headings)


2. On the toolbar menu click on “Table”


3. In the Table Menu click on “Convert”


4. In the Convert options click on “Text to Table XE "Text to Table" ”


5. The instant result shown as Table 2 below:


Table 4.2 - Example of a Text to Table XE "Text to Table"  Conversion


		Analyte

		Method Type/Principle

		Detection Limit

		Precision



		Arsenic

		Flame Atomic Absorption

		100 ug/L

		20%



		Cadmium

		ICP-Atomic Emission

		1 ug/L

		10%



		Lead

		Graphite Furnace Atomic Absorption

		60 ug/L

		15%





Using MS Word you may then convert XE "convert"  the basic table to whatever format headings and body that you prefer.


4.5 Appending Files to Build a Master QAPP XE "Master QAPP" 

A “Master QAPP XE "Master QAPP" ” will automatically be constructed for you from a “macro XE "macro" ” that has been imbedded in the file named “CoverPage.doc XE "CoverPage.doc" ” that is downloaded from the SWAMP Advisor web site. The link to download the CoverPage.doc file is in the right side frame of the opening screen of the SWAMP Advisor and also in the right side frame of one of the last questions in Element 24 XE "Element 24" . When you click on this link you should save this file to the same folder in which all of your document files XE "document files"  from each element were saved.

Follow the instructions below:

· Your QAPP folder XE "QAPP folder"  will contain 21 files all ending in “-QAPP.rtf”


· After all files are present then you download the Cover Page XE "Cover Page" .


1. Download link is in the right side panel of the SWAMP Advisor opening page and also in the last right side panel of the last “element” (Element 24 XE "Element 24" ).


1. Save the cover page to your QAPP folder XE "QAPP folder" . It has a macro that will automatically find and append each of the 21 files in the correct order and then to automatically prepare the table of contents. 


1. Go to the bottom of the page and press the “Alt” and letter “a” keys (Alt + A) to activate the macro.


2. Complete all final edits and formatting (including changing comma-delimited XE "comma-delimited"  tables into regular table format XE "regular table format" ), rename and save the file, and print it.


If there are any problems then refer to Sections 1.5 or 1.6 for solutions to all known problems that could happen.

4.6 Building a Table of Contents XE "Table of Contents" 

When the macro XE "macro"  described in Section 3.5 has competed building your Master QAPP XE "Master QAPP"  document then it automatically also builds your Table of Contents XE "Table of Contents"  in Section 2.0. Therefore, you should not have to do anything to prepare your Table of Contents.


However, if you need to modify sections of your QAPP (for example, adding or deleting sections) then follow the instructions below to manually build a Table of Contents XE "Table of Contents" .


1. Move your cursor to a blank line below “Section 2.0 – Table of Contents XE "Table of Contents" .”

2. Click on “Insert” from the toolbar.


3. Select “Reference XE "Reference" ” from the drop down menu.


4. In the selection box from “Reference XE "Reference" ” select “Index and Tables XE "Index and Tables" .”

5.  Next, select “Table of Contents XE "Table of Contents" ” from the menu tab and review the options available to you. Select those that are applicable and that you wish to use. The headings used for the element files include Headings 1, 2 and 3 plus Heading 4 for Table Names. 


6. As soon as you click on the “Okay” button a new Table of Contents XE "Table of Contents"  will instantly and automatically be generated below your cursor.


5.0 Instructions for Preparing Element Documents


The SWAMP Advisor is an expert knowledge system that uses “decision trees XE "decision trees" ” to provide appropriate answers and advice for your QAPP document files XE "document files" .  There are many different technical approaches to any given project. For example, one project may require field analyses XE "analyses"  involving temperature, specific conductivity and selected nutrient analytes XE "analytes"  for water quality monitoring while another may require laboratory analyses of PCBs, lead and arsenic. Perhaps a third project may require both field and laboratory analyses. Therefore, in these examples, the three QAPPs being prepared would each need different information in the elements that describe problem definition (Element 5), project / task description (Element 6 XE "Element 6" ), quality objectives and criteria for measurement data (Element 7 XE "Element 7" ), sample processing design (Element 10 XE "Element 10" ), sampling methods XE "sampling methods"  (Element 11 XE "Element 11" ), sample handling and custody XE "custody"  (Element 12 XE "Element 12" ), analytical methods (Element 13 XE "Element 13" ), and quality control XE "quality control"  (Element 14 XE "Element 14" ) among others. Figure 5.1 illustrates this concept.
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Figure 5.1. Conceptual Diagram of a Decision Tree


Obviously, it is not feasible to discuss all possible branches of every decision tree because there would be thousands of possibilities. Therefore, in the illustrations used for the instructions provided with each element below, what could be a “typical” scenario is arbitrarily selected. You may choose to follow a different path for your needs but the choices selected for illustrating the use of each element’s decision tree path will cover the basic concepts that you will encounter.


5.1 Element 1 XE "Element 1"  – Title and Approval Page Information


5.1.1 - Content Checklist for Element 1 XE "Element 1" 

In order to complete the Title Page, you will need the following information: 


· The title XE "title"  of your project, 


· Your proposal number XE "proposal number" , 


· The date XE "date"  of your QAPP, 


· The name of the organization responsible for drafting and executing the plan,


· The name of the applicant organization’s project manager XE "project manager" ,


· The name of the applicant organization’s quality assurance officer XE "quality assurance officer" ,


· The names of any other people in the applicant organization’s signature table XE "signature table" ,


· The name of the California State Water Control Board’s contract manager XE "contract manager" ,


· The name of the California State Water Control Board’s quality assurance officer XE "quality assurance officer" , and


· The names of any other people in grant organizations signature table XE "signature table" .


5.1.2 - Instructions for Element 1 XE "Element 1" 

Remember, you can not use any commas XE "commas"  when entering information that will be used to build a comma-delimited XE "comma-delimited"  table in this element.


The first question (1.1a) asks you to enter the name of your project. Type your project name in the space provided in the left side screen and click on the “OK” button.


Note: A concise title XE "title"  can convey a great deal of information about the scope and intent of your project with just a few words. It can also help guide people looking for similar information towards your work.


Question 1.1b asks you to enter the proposal number XE "proposal number"  for your project. This may be assigned by the funding organization or by your organization but it is a unique number used to track proposal submissions. Enter the number in the space provided in the left side screen and click on the “OK” button.


Question 1.1c asks you to enter the date XE "date"  of this QAPP. You may enter today’s date or a date in the future in which you plan to submit the QAPP. This date can easily be edited, if needed, on the date that you actually do submit the QAPP. Enter the date in the space provided in the left side screen and click on the “OK” button.


Question 1.1d asks you to enter your organization’s name. Enter the name in the space provided in the left side screen and click on the “OK” button.


Question 1.2a asks you to enter the name of the project manager XE "project manager" . Enter the name in the space provided in the left side screen and click on the “OK” button.


Question 1.2b asks you to enter the name of the quality assurance officer XE "quality assurance officer" . Enter the name in the space provided in the left side screen and click on the “OK” button.


The project manager XE "project manager"  and quality assurance officer XE "quality assurance officer"  questions provide the minimum required information required for a signature table XE "signature table"  from the applicant organization. However, you may wish to add additional people to this signature table. If so, then select “Yes” to the additional signature question 1.2c and you will be asked to enter the next person’s name and title XE "title"  in the spaces provided. Additionally, you may opt to add a fourth person’s name and title to the organization’s signature table by repeating the same process. However, we will stop with question 1.2b (entering the name of the quality assurance officer).


Having selected “No” to the addition of more people to the signature table XE "signature table"  in question 1.2c, the next question (1.2d) asks you to enter the name of the funding agency’s contract manager XE "contract manager" . This will be a person from the California State Water Resources Board XE "California State Water Resources Board" . Enter the name in the space provided in the left side screen and click on the “OK” button.


Question 1.2e asks you to enter the name of the funding agency’s quality assurance officer XE "quality assurance officer" . This will be a person from the California State Water Resources Board XE "California State Water Resources Board" . Enter the name in the space provided in the left side screen and click on the “OK” button.


The contract manager XE "contract manager"  and quality assurance officer XE "quality assurance officer"  questions provide the minimum required information required for a signature table XE "signature table"  from the California State Water Resources Board XE "California State Water Resources Board" . However, you may wish to add additional people to this signature table. If so, then select “Yes” to the additional signature question 1.2f and you will be asked to enter the next person’s name and title XE "title"  in the spaces provided. Additionally, you may opt to add a fourth person’s name and title to the California State Water Resources Board’s signature table by repeating the same process. However, we will stop with question 1.2e (entering the name of the quality assurance officer).


Once you have selected “No” to the choice in question 2e (or alternatively, have continued to add one or two other people to the signature table XE "signature table" ) then a draft of your answers will immediately be presented in the left side panel for your review. If you did not select any optional additional people to add to the tables then you will note a series of commas XE "commas"  in the lines following the signature names and titles. Ignore these commas because they represent “holding spaces” for a comma-delimited XE "comma-delimited"  table that could include more people; your Element 1 XE "Element 1"  QAPP text document will not show these extra commas. In the future, if desired, a more advanced display of answers that exactly mimics the actual text documents produced could replace the current display.


Click on the “OK” button when you are finished reviewing the displayed draft information.


The next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 1 XE "Element 1"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “1-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the Organization’s Signature Table XE "Organization’s Signature Table" .


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


Repeat this process for the second table for California State Water Resource Board.


After the two tables have been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.


This completes the work with Element 1 XE "Element 1" .


Note that heading “2.0 – Table of Contents XE "Table of Contents" ’ is located at the bottom of this page. It is a placeholder for the Table of Contents which is automatically prepared from a “macro XE "macro" ” in the “CoverPage.doc XE "CoverPage.doc" ” file and nothing needs to be done with it. 


5.2 Element 2 XE "Element 2"  – Table of Content Information


5.2.1 - Content Checklist for Element 2 XE "Element 2" 

In order to complete the Table of Contents XE "Table of Contents" , you will need the following information: 


· All 21 element document files XE "document files"  correctly named and saved in the folder where the file named “CoverPage.doc XE "CoverPage.doc" ” is located.


· The downloaded and saved file named “CoverPage.doc XE "CoverPage.doc" ” in the same folder where all 21 completed and correctly named document files XE "document files"  have been saved.


5.2.2 - Instructions for Element 2 XE "Element 2" 

The Table of Contents XE "Table of Contents"  for Element 2 XE "Element 2"  will automatically be completed from a “macro XE "macro" ” that is embedded in the file named “CoverPage.doc XE "CoverPage.doc" ”


After CoverPage.doc XE "CoverPage.doc"  has been downloaded from the folder where all 21 correctly named QAPP documents have been saved then open it and place your cursor at the bottom of the page where the instructions on that page indicate.


With your cursor in place at the bottom of the page, simultaneously press the “Alt” and the letter “a” keys (Alt + a ). This action will activate the macro XE "macro"  which, in turn, will automatically add each of the 21 QAPP document files XE "document files"  in the correct order. Next, the macro will automatically prepare the Table of Contents XE "Table of Contents"  under the “2.0 Table of Contents” heading.


Once the Table of Contents XE "Table of Contents"  has finished its work then save the file and, if you wish, rename the file.


5.3 Element 3 XE "Element 3"  – Distribution List Information


5.3.1 - Content Checklist for Element 3 XE "Element 3" 

In order to complete this list, you will need the following information: 


· The name, title XE "title" , organization, and telephone number XE "telephone number"  of each QAPP recipient.


· The above information for the following people: Contractor Program Manager XE "Contractor Program Manager" , Contractor Quality Assurance Officer XE "Contractor Quality Assurance Officer" , the California State Water Resources Board XE "California State Water Resources Board"  Contract Manager, and the California State Water Resources Board Quality Assurance Officer XE "California State Water Resources Board Quality Assurance Officer" . Note that these four people’s information is also required in Element 1 XE "Element 1" .


The following list is not mandatory; it is a list of potential people who also may logically be included in your distribution list if you wish.


· Laboratory / Field Team Director 


· Laboratory / Field Team QA Officer 


· Data Processors / Reviewers 


· Statisticians / Modelers 


· Contractors / Subcontractors 


· Regulators


5.3.2 - Instructions for Element 3 XE "Element 3" 

The first screen of this element provides background information. You may click on the links XE "links"  in the right side screen to see an example of a distribution table XE "distribution table"  and to get advice on the content of this table. Click the “OK” button to proceed to the first question. Remember, you can not use any commas XE "commas"  when entering information that will be used to build a comma-delimited XE "comma-delimited"  table in this element.


The contractor’s program manager name is the first required information. Enter that person’s name in the space provided in the left side screen Number 3.1 and click on the “OK” button.


The next questions ask for the telephone number XE "telephone number"  and a unique QAPP copy number XE "unique QAPP copy number"  for the program manager. Enter each of these pieces of information in the space provided in the left side screen and click on the “OK” button. A unique copy number is assigned to each QAPP that is distributed so that they can be tracked.


The contractor’s quality assurance officer XE "quality assurance officer"  is the second required information. . Enter that person’s name in the space provided in the left side screen Number 3.2 and click on the “OK” button.


The next questions ask for the telephone number XE "telephone number"  and a unique QAPP copy number XE "unique QAPP copy number"  for the quality assurance officer XE "quality assurance officer" . Enter each of these pieces of information in the space provided in the left side screen and click on the “OK” button. 


The California State Water Resources Board XE "California State Water Resources Board"  contract manager XE "contract manager"  is the third required information. . Enter that person’s name in the space provided in the left side screen Number 3.3 and click on the “OK” button.


The next questions ask for the telephone number XE "telephone number"  and a unique QAPP copy number XE "unique QAPP copy number"  for the contract manager XE "contract manager" . Enter each of these pieces of information in the space provided in the left side screen and click on the “OK” button. 


The California State Water Resources Board XE "California State Water Resources Board"  quality assurance officer XE "quality assurance officer"  is the fourth required information. . Enter that person’s name in the space provided in the left side screen Number 3.4 and click on the “OK” button.


The next questions ask for the telephone number XE "telephone number"  and a unique QAPP copy number XE "unique QAPP copy number"  for the Board’s quality assurance officer XE "quality assurance officer" . Enter each of these pieces of information in the space provided in the left side screen and click on the “OK” button. 


The next question asks if there are additional people that you want to add to your distribution list table XE "distribution list table" . If there are others then select “Yes” and you will be asked to enter their title XE "title" , name, phone number XE "phone number" , and a unique QAPP copy number XE "unique QAPP copy number"  respectively.  You may also go through the procedure again to add a second (and last) optional person to the distribution list for a total of 4 required names and 2 optional names. The sixth person is the last who can be added using the SWAMP Advisor to build this particular table. If additional people are desired then it is easier to simply add rows to the existing table and enter the information for them.


Once you have finished adding information to your table then a draft of your answers will immediately be presented in the left side panel for your review. If you did not select any optional additional people to add to the tables then you will note a series of commas XE "commas"  in the lines at the bottom of the comma-delimited XE "comma-delimited"  table. Ignore these commas because they represent “holding spaces” for a comma-delimited table XE "comma-delimited table"  that could include more people; your QAPP text document will not show these extra commas. In the future, if desired, a more advanced display of answers that exactly mimics the actual text documents produced could replace the current display.


Click on the “OK” button when you are finished reviewing the displayed draft information.


When you have completed reviewing the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 3 XE "Element 3"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “3-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the Distribution Table.


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


After the table has been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.


This completes the work with Element 3 XE "Element 3" .


5.4 Element 4 XE "Element 4"  – Project / Task Organization List Information


5.4.1 - Content Checklist for Element 4 XE "Element 4" 

In order to complete this list, you will need the following information: 


· The name, organization affiliation, title XE "title"  and contact information (e.g., phone number XE "phone number" , fax number XE "fax number"  and e-mail address XE "e-mail address" ) for each person that has a lead role in the project.


The following list is not mandatory; it is a list of potential people who also may logically be included in your project / organization list if you wish.


· State or Regional Board Project Manager XE "State or Regional Board Project Manager"  


· State or Regional Board Quality Assurance (QA) Program Manager 


· State Grant Applicant Manager XE "State Grant Applicant Manager"  


· Grant Applicant's QA Program Manager XE "Grant Applicant's QA Program Manager"  


· Grant Applicant's Laboratory Director XE "Grant Applicant's Laboratory Director"  


· Grant Applicant's Laboratory/Field QA Officer 


· Grant Applicant's Field Activities Director 


· Grant Applicant's Data Management Director 


· Grant Applicant's Sub-contractors


5.4.2 - Instructions for Element 4 XE "Element 4" 

The first screen of this element provides background information. You may click on the links XE "links"  in the right side screen to see an example of a project organization table and to get advice on the content of this table. Click the “OK” button to proceed to the first question.


The first question asks you to briefly describe the proposed organization for your project. You may already have this information in your Monitoring Plan XE "Monitoring Plan"  and, if so, just copy and paste it. Otherwise, provide the requested information in paragraph form. An example from the Sycamore Creek XE "Sycamore Creek"  Monitoring Plan shows the kind of information that should be included (this is not an actual plan but, rather, an example prepared by SWAMP staff).


Question 4.1.1 asks for the name of the first person you want in your table. Enter the information in the space provided in the left side screen and click on the “OK” button. Remember, you can not use any commas XE "commas"  when entering information that will be used to build a comma-delimited XE "comma-delimited"  table in this element.


Question 4.1.2 asks for the organizational affiliation of the first person. Enter the information in the space provided in the left side screen and click on the “OK” button.


Question Number 4.1.3 asks for the title XE "title"  of the first person. Enter the information in the space provided in the left side screen and click on the “OK” button.


Question 4.1.4 asks for contact information for the first person. . Enter the information in the space provided in the left side screen and click on the “OK” button.


Repeat this process to add information for two additional people. After information for the first three people have been added the next question (4.4) asks if you want to add information for an additional person. If you do, then repeat the process above (remembering not to use any commas XE "commas" ).


After information for the fourth person has been added the next question (4.5) asks if you want to add information for an additional person. If you do, then repeat the process above, otherwise select “No” and click on the “OK” key. This is the last person’s information that can be added using the SWAMP Advisor to build this particular table. If additional people are desired then it is easier to simply add rows to the existing table and enter the information for them.


Question 4.3.5 asks you to describe the duties of the key personnel XE "key personnel"  that you have included in your table. You may copy this information from your Monitoring Plan XE "Monitoring Plan"  if it is available or else provide it in paragraph form. A brief example that shows the kind of information that should be included appears in the right side screen. You may copy and modify this to fit your project needs if you wish, remembering that duties of the key personnel in your table should be described.


Section 4.2 of this QAPP document requires a description of the quality assurance officer XE "quality assurance officer" ’s role. Please enter that information in the space provided in the left side screen of question 4.2 and click on the “OK” button. A brief example that shows the kind of information that should be included appears in the right side screen. You may copy and modify this to fit your project needs if you wish.


Section 4.3 of this QAPP document requires a description of the person or persons responsible for updating XE "updating"  the QAPP. Please enter that information in the space provided in the left side screen of question 4.3 and click on the “OK” button. A brief example that shows the kind of information that should be included appears in the right side screen. You may copy and modify this to fit your project needs if you wish.


Once you have finished adding information to Section 4.3 then a draft of your answers will immediately be presented in the left side panel for your review. If you did not select any optional additional people to add to the tables then you will note a series of commas XE "commas"  in the lines at the bottom of the comma-delimited XE "comma-delimited"  table. Ignore these commas because they represent “holding spaces” for a comma-delimited table XE "comma-delimited table"  that could include more people; your QAPP text document will not show these extra commas. In the future, if desired, a more advanced display of answers that exactly mimics the actual text documents produced could replace the current display.


Click on the “OK” button when you are finished reviewing the displayed draft information.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 4 XE "Element 4"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “4-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the Distribution Table.


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


After the table has been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.


This completes the work with Element 4 XE "Element 4" .


5.5 Element 5 – Problem Definition / Background  Information


5.5.1 - Content Checklist for Element 5


In order to complete this section, you will need the following information: 


· The problem statement XE "problem statement"  in paragraph format; i.e., a summary of each problem XE "summary of each problem"  being addressed by the project.

· The expected outcomes XE "expected outcomes"  from your project; i.e., a summary of how the project information would be used.


· A brief statement of any regulatory XE "regulatory"  or water quality criteria XE "water quality criteria"  that your project addresses.

5.5.2 - Instructions for Element 5


The first screen of this element (5.0) provides background information on what information a reviewer may typically expect to find in this element’s document based on what the objectives of the project are. Useful examples and advice are provided from links XE "links"  in the right side screen. After you have finished reading the information provided, then click on the “OK” button to proceed to the first question.

Question 5.1 asks for a description of the problem that you are addressing. You should include a summary of the problem(s) that will be examined by your project, an explanation of how your project will address the identified problem(s), and a brief description of the project's study area XE "project's study area" . The right side screen provides useful information and an example passage that you may copy and paste, with appropriate edits to fit your needs, if you wish. Enter the information in the space provided in the left side screen and click on the “OK” button.

Question 5.2 asks for a brief statement of the expected decisions XE "expected decisions"  or outcomes of your project. You would typically include the decision(s) or outcome(s) expected of your project, the specific information or data that will be produced by your project, and the expected use(s) of project information. The right side screen provides useful information and an example passage that you may copy and paste, with appropriate edits to fit your needs, if you wish. Enter the information in the space provided in the left side screen and click on the “OK” button.

Question 5.3 asks for a brief statement of any water quality or regulatory XE "regulatory"  criteria that relate to your project. You would typically include water quality or regulatory criteria associated with the project and any future limits XE "limits"  or regulations that may result from the project. If there are none then state that fact. The right side screen provides useful information and an example passage that you may copy and paste, with appropriate edits to fit your needs, if you wish. Enter the information in the space provided in the left side screen and click on the “OK” button.

Once you have finished adding information to Section 5.3 then a draft of your answers will immediately be presented in the left side panel for your review. Click on the “OK” button when you are finished reviewing the displayed draft information.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 5 and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “5-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 5.


5.6 Element 6 XE "Element 6"  – Project / Task Description

5.6.1 - Content Checklist for Element 6 XE "Element 6" 

In order to complete this section, you will need the following information: 


· A list of report types XE "report types"  that you plan to generate with the project.

· A list of the types of sampling stations XE "sampling stations"  that will be employed.


· A brief description of the sampling area XE "sampling area"  and how frequently you plan to sample it.

· A list of the “media XE "media" ” you will be sampling.

· A list of the sampling techniques XE "sampling techniques"  you plan to use for water samples XE "water samples" .


5.6.2 - Instructions for Element 6 XE "Element 6" 

The first question (6.1.1) asks whether you plan to generate new laboratory and/or field data XE "field data"  or not.  In most cases the answer will be “Yes.” Depending on your answer you will go down two very different branches of related questions. We are going to assume that you have answered “Yes” and clicked on the “OK” button.

Question 6.1.2 provides background information about various typical reports that are associated with environmental monitoring projects. When you have finished reading this information then select the “Continue” button and click on the “OK” button.


Question 6.1.3 lists numerous standard report types XE "report types" . You should check all that apply and then click on the “OK” button to continue to the next screen. This information will then automatically be included in the text document for this element.

Question 6.1.3.1 provides space for you to describe any additional (customized) reports. Useful advice and information are provided in the right side screen. If no additional reports are planned then state that and click on the “OK” button to continue.

Question 6.1.4.1 provides a list of common sampling station types XE "sampling station types"  used with SWAMP projects and you may select all that apply. If there is another type of sampling station that is not listed, and that your project will use, then check the “Other” box and you will be able to describe it in Number 6.1.4.1 – Other. After you are finished with these questions click the “OK” button to continue to the next question.

Question 6.1.4.2 asks you to list the frequency XE "frequency"  of your sampling. This may be daily, weekly, once every few months, etc. Note that your answer should not be a complete sentence but rather the end of a sentence that begins with “Samples will be collected ………..” Enter the information in the space provided in the left side screen and click on the “OK” button.

Question 6.1.5 asks you to briefly identify the sampling area XE "sampling area" . Enter the information and click on the "OK" button.

Question 6.1.7 asks whether you will be conducting measurements in the field, in a laboratory, or both. Select one of the three possibilities and click on the “OK” button. The most complex example assumes that you will conduct both field and laboratory measurements XE "laboratory measurements"  and that is the scenario that we will describe in the next screens.


Question 6.1.6.0 asks you to identify the media XE "media"  that will be sampled. U.S. EPA classifies samples into main categories XE "categories"  called "media." These include water, sediments and soils, and tissues XE "tissues"  from organisms XE "organisms" . However, these categories may not be sufficient for your plans so if you plan to sample an additional category (for example, waste containers XE "containers" ) then select "Other" as a choice. SWAMP currently has bioassessment XE "bioassessment"  protocols for wadeable streams XE "wadeable streams"  and that is what will be considered if you "select tissues / organisms." For other situations please select "Other" as a choice. Click the “OK” button after you have made your selections. If you selected “Other” then you will be able to describe your sampling medium XE "sampling medium" ; otherwise you will not be asked to do that.


The first medium considered is water samples XE "water samples"  and question 6.1.6.1 provides a list of four commonly used techniques plus the ability to select “Other” and describe a different sampling technique if you wish. Descriptions and examples of the four basic techniques are available from a link in the right side screen. Select all techniques that apply to your project plans and click the “OK” button to continue.

Turning to the next medium – sediment XE "sediment"  – question 6.1.6.2.1 asks you to describe the sediment and how the samples will be used. Some example text that you may copy and edit to meet your plans, if you wish, appears in the right side screen.


The third medium – tissues XE "tissues"  – can involve various animal organs XE "animal organs"  and/or new bioassay XE "bioassay"  questions XE "bioassay questions" . Select all that apply and click on the “OK” button to continue; we will select both for this discussion.


Question 6.1.6.3.0A asks for a description of the organisms XE "organisms"  that you plan to collect and how they will be used. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.


Question 6.1.6.3.1.is the beginning of a series of questions describing your bioassay XE "bioassay"  plans so that the results will be SWAMP-comparable XE "SWAMP-comparable" . All SWAMP-funded bioassessments are required to follow guidance specified in the Sampling" February 2007 Benthenic Sampling Standard Operating Procedures
. This includes collecting samples using two methods (i.e., targeted-riffle XE "targeted-riffle"  composite and reachwide benthos composite XE "benthos composite" ) under most conditions with only two exceptions. For the purposes of this question – and the following bioassay questions XE "bioassay questions"  – we are going to assume that you will meet all SWAMP-comparable requirements. Therefore, select “Yes” and click on the “OK” button to continue. 

Question 6.1.6.3.1A asks for a brief description of your plans for macroinvertebrate XE "macroinvertebrate"  collection. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.1.6.3.2 asks if you plan to include at least 10% replication on all macroinvertebrate XE "macroinvertebrate"  samples because this is a requirement for SWAMP-comparable XE "SWAMP-comparable"  data. Select “Yes” and click on the “OK” key to continue. 


Question 6.1.6.3.2A asks for a brief description of your plans. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.1.6.3.3 asks if you plan to use the Southwest Association of Freshwater Invertebrate Taxonomists (SAFIT XE "SAFIT" ) and utilize the SAFIT Level II taxonomic effort (STE) because this is a requirement for SWAMP-comparable XE "SWAMP-comparable"  data. Select “Yes” and click on the “OK” key to continue. 

Question 6.1.6.3.3A asks for a brief description of your plans. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.1.6.3.4 asks if you plan to include a minimum of 10% reidentification of samples using an external quality assurance laboratory XE "external quality assurance laboratory"  because this is a requirement for SWAMP-comparable XE "SWAMP-comparable"  data. Select “Yes” and click on the “OK” key to continue. 

Question 6.1.6.3.4A asks whether or not the external quality assurance laboratory XE "external quality assurance laboratory"  has been approved by the SWAMP Quality Assurance Officer XE "SWAMP Quality Assurance Officer"  because this is a requirement for SWAMP-comparable XE "SWAMP-comparable"  data. Select “Yes” and click on the “OK” key to continue. 

Question 6.1.6.3.4B asks for a brief description of the approval that you have received from the SWAMP Quality Assurance Officer XE "SWAMP Quality Assurance Officer" . A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.1.6.3.5 asks you to select which California latitude XE "California latitude"  best describes where you plan to sample and you may select the one that best describes your plans. This will enter a statement as to which index period XE "index period"  you plan to use in your text document. All SWAMP-funded bioassessments are required to include sampling during the most appropriate index period (i.e., time of year that samples are collected). This is to ensure data comparability by requiring that samples are collected during standardized index periods. Since the appropriate index period varies at different latitudes and elevations, the best times to sample will vary by geographic locations XE "geographic locations"  within the state. Select the most appropriate answer and click on the “OK” button to continue.

Question 6.1.6.3.5A through 6.1.6.3.5D depends on which geographic location XE "geographic location"  you selected – you will only be asked one of these questions. You are asked to enter a brief description of the appropriate sampling time period XE "sampling time period" . A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.

Question 6.1.6.3.6 asks if you plan to follow SWAMP-comparable XE "SWAMP-comparable"  guidance and use a minimum organism fixed-count per sample XE "organism fixed-count per sample"  of 600. Select “Yes” and click on the “OK” button to continue.


Question 6.1.6.3.6A asks if you plan to use the grid-tray method XE "grid-tray method" . Select “Yes” and click on the “OK” button to continue.


Question 6.1.6.3.6B asks for a description of your use of the grid-tray method XE "grid-tray method" . A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.

Question 6.1.6.3.7 asks if you plan to include the full suite of physical habitat XE "physical habitat"  methods as recommended by SWAMP. Select “Yes” and click on the “OK” button to continue.


Question 6.1.6.3.7A asks for a description of your use of the full suite of physical habitat XE "physical habitat"  methods. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.1.6.3.8 asks if you would like a preview XE "preview"  of your answers to the bioassessment XE "bioassessment"  segment of Element 6 XE "Element 6"  text. This is because this segment was so long and involved that you may wish to see a preview so that you can go back and change any that you need to. You will see all of this information again in the full Element 6 preview. Select “Yes” and click on the “OK” button to continue.


After previewing your answers click on the “OK” button to continue if you are satisfied with them.


Question 6.1.8 asks you to select the type of weather conditions under which sampling will occur. Select the appropriate answer and a statement to that effect will automatically be entered into your document text. Click on the “OK” button to continue. 


Question 6.2 asks you to select which of three major analyte groups will be used during your project. Select all three and click on the “OK” button to continue. Each group will be addressed in sequence.


Question 6.2.1 asks you to describe the field testing XE "testing"  parameters XE "field testing parameters"  that you plan to conduct. Typical examples include dissolved oxygen, specific conductivity, pH, temperature, turbidity, salinity, depth, flow velocity, etc. Enter the requested information and click on the “OK” button.

Question 6.2.1.1.asks you to select any of the ELISA XE "ELISA"  kit types that you plan to use. You may select all that apply and then click on the “OK” button to continue.


Question 6.2.1.2 asks you to describe the field test kits XE "field test kits"  that you plan to use. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.


Question 6.2.1.3 asks you to select all of the laboratory analytical groups XE "laboratory analytical groups"  that you plan to monitor. Each group that you select will lead to a new question where you may list the specific analytes XE "analytes"  that you plan to analyze for. For this exercise select Conventional Analytes XE "Conventional Analytes"  in Water (QMP Table A1a) and Synthetic Compounds XE "Synthetic Compounds"  in Water (QMP Table A10) and click on the “OK” button to continue.

As a result of your selection of Conventional Analytes XE "Conventional Analytes"  in Water question Number 6.2.1.3.B.1a is asked and you may enter any from the list of analytes XE "analytes"  that are in the right side screen and then click on the “OK” button to continue..


As a result of your selection of Synthetic Compounds XE "Synthetic Compounds"  in Water question Number 6.2.1.3.B.10 is asked and you may enter any from the list of analytes XE "analytes"  that are in the right side screen and then click on the “OK” button to continue..


Question 6.3 asks whether you have an acceptable project schedule XE "project schedule"  or whether you would like the SWAMP Advisor to help you to develop one. Select the second choice to let the SWAMP Advisor help to prepare a schedule table XE "schedule table" . This will allow you to build a schedule table with four separate activities. Although you will probably have more than four activities, once the table is built for you then it is easier to simply add more rows to the bottom of it and enter the appropriate information in them in the text document than to continue to add more activities using the SWAMP Advisor. 

Question 6.3.1.1.a asks you to enter the name of the first activity in your schedule table XE "schedule table" . For this exercise enter “Field sampling XE "Field sampling" ” and click on the “OK” button to continue.


Question 6.3.1.1b asks you to enter the initiation date XE "date"  of the first activity. Enter an example date of 1/5/2009 and click on the “OK” button.


Question 6.3.1.1c asks you to enter the completion date XE "date"  of the first activity. Enter an example date of 3/1/2009 and click on the “OK” button.


Question 6.3.1.1d asks you to enter the deliverable XE "deliverable"  of the first activity. Enter an example of “Field Data Report” and click on the “OK” button.


Question 6.3.1.1e asks you to enter the due date XE "date"  of the deliverable XE "deliverable" . Enter an example date of 4/1/2009 and click on the “OK” button. This completes the information for the first activity in the schedule table XE "schedule table" . The same questions will be asked again three more times to enable you to enter three more activities in the schedule table. 


The Question Numbers for the repeat questions are 6.3.1.2a through 6.3.1.2e, and 6.3.1.3a through 6.3.1.3e, and 6.3.1.4a through 6.3.1.4e. Enter information for each of these questions and click on the “OK” button to continue after each entry. 

Question 6.3.1 asks you to provide a brief explanation of the scheduling of key project events XE "key project events" . A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.4.1 asks you to provide a description of the general geographic location XE "geographic location"  of the project sampling. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 6.4.2 asks you to provide captions for any maps XE "maps"  and photographs XE "photographs"  that you use in Element 6 XE "Element 6" . These will serve to remind you where the figures should go. If you do not plan to use maps or photographs then state that fact in the space provided and click on the “OK” button.


Question 6.5.1 asks you to select any of the typical constraints XE "constraints"  that could negatively affect your project. Select any that you feel are appropriate and pre-formatted text will be inserted into your text document describing these. You may preview XE "preview"  these statements from a link in the right side screen. If you select “Other constraints” then you will be able to describe your own constraints.


Question 6.6 asks if you want to review all your answers. Select “Yes” and click on the “OK” button to see all of them. 


Click on the “OK” button when you are finished reviewing the displayed draft information.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 6 XE "Element 6"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “6-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the table.


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


After the table has been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.


This completes the work with Element 6 XE "Element 6" .


5.7 Element 7 XE "Element 7"  – Quality Objectives and Criteria for Measurement Data

5.7.1 - Content Checklist for Element 7 XE "Element 7" 

In order to complete this section, you will need the following information: 


· A statement of your Data Quality Objectives XE "Data Quality Objectives" .

· A statement of your Measurement Quality Objectives XE "Measurement Quality Objectives" .


· A list of analytes XE "analytes"  to be measured.


5.7.2 - Instructions for Element 7 XE "Element 7" 

The first screen (7.0.1) of this element provides background information and two references that may be helpful as you develop answers for this section of your QAPP.

Question 7.0.2 asks how many study questions XE "study questions"  (or lines of inquiry XE "lines of inquiry" ) there are for your project. For this exercise assume that there are two: first, water quality assessment and, second, determining the source of pollution that will be monitored. Therefore, of the two possible selections, choose the one with multiple study questions and click on the “OK” button.

Question 7.1 provides background information for developing Data Quality Objectives XE "Data Quality Objectives" . Read or download as many of the documents in the right screen as you need in order to understand this important and complex process and then click on the “OK” button to proceed.


Question 7.2.1 asks for a concise statement of the first study question XE "study question" . As an example, you may enter “Water Quality Assessment” and then click on the “OK” button. This statement will be entered into your Element 7 XE "Element 7"  text document and you will copy and paste it into the first column of each of the tables that relate to this monitoring data.


Question 7.2.2 asks for an initial Data Quality Objective (DQO XE "DQO" ). A generic example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. The DQO process XE "DQO process"  is an iterative one and you should return later and revise it to make it specific for your planned project. Click on the “OK” button to continue. 


Question 7.3 asks you to describe your Measurement Quality Objectives XE "Measurement Quality Objectives"  (MQOs). A generic example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 7.4 asks you to select which “groups” of analytical parameters you will use for the study question XE "study question" . Since, in this example, water quality monitoring will be conducted, the appropriate selection is “Discrete Field Methods XE "Discrete Field Methods" ” and the link on the right side screen provides additional support for this choice. Select this choice and click on the “OK” button to proceed.


Question 7.5 lists available field measurement parameters XE "field measurement parameters" . There are only two at present – more will be added later. Select the two top choices and click on the “OK” button. Questions involving each parameter will be provided in sequence.

Question 7.5.1 lists several commonly used instruments XE "instruments"  for measuring specific conductivity. MQOs are specific for each instrument because they all have difference performance characteristics. Select any that you wish and the MQO XE "MQO"  information for each selected automatically will be entered into your Element 7 XE "Element 7"  text document tables.

Question 7.5.2 lists several commonly used instruments XE "instruments"  for measuring temperature. MQOs are specific for each instrument because they all have difference performance characteristics. Select any that you wish and the MQO XE "MQO"  information for each selected automatically will be entered into your Element 7 XE "Element 7"  text document tables.


A preview XE "preview"  of your answers so far will be displayed. When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 7 XE "Element 7"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “7-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the table.


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


After the table has been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.

Question 7.7 asks if you wish to loop through the questions again for a different study question XE "study question" . Since this exercise has only completed the first of two study questions XE "study questions" , select “Yes” and click on the “OK” button.


This action returns you to Question 7.2.1 and your initial answer is present. The second study question XE "study question"  involves monitoring to discover the source of pollutants so delete the residual answer and replace it with “Source ID” and click on the “OK” button.


Question 7.2.2 contains the original DQO XE "DQO"  statement which may be retained. Click on the “OK” button to continue.


Question 7.2.3 contains the original MQO XE "MQO"  statement which may be retained. Click on the “OK” button to continue.


Question 7.4 is the “Group Menu” and laboratory measurements XE "laboratory measurements"  will be used for the Source Identification Study Question. Therefore, “uncheck” the box marked “Discrete Field Methods XE "Discrete Field Methods" ” by clicking on it again and check the box marked “Laboratory measurements” then click on the “OK” button.

Question 7.6 presents a list of analytes XE "analytes"  that are analyzed in a laboratory. Select any that you wish. You are next presented a preview XE "preview"  of your answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 7 XE "Element 7"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” but DO NOT NAME THIS SECOND STUDY QUESTION FILE 7-QAPP. The reason is that you have already saved the document file from the first study question XE "study question"  by that name and if you use it again you will copy over the first file. Instead, name this file, “7a-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.

Remember that you will have to copy and paste the information from this file into your Master QAPP XE "Master QAPP"  document because the macro XE "macro"  in your CoverPage.doc XE "CoverPage.doc"  file was not instructed to find multiple files for a given element to append.  This feature will be added, if possible, in the future.

You will be returned to Question 7.7. This time choose “No, I am finished” and click on the “OK” button. 


This completes the work with Element 7 XE "Element 7" . You will later copy some of the tables from Element 7 to other element text documents after you complete them. Each will contain a reminder for you.


 5.8 Element 8 XE "Element 8"  – Special Training Needs / Certification

5.8.1 - Content Checklist for Element 8 XE "Element 8" 

In order to complete this section, you will need the following information: 


· Lists of special training XE "training"  that is relevant to your monitoring plan.

· Lists of who received training XE "training" .


· Lists of who provided training XE "training" 

· Lists of any training XE "training"  records or certificates relevant to your monitoring plan.


· Information on where training XE "training"  records or certificates are kept.


· Lists of training XE "training"  course titles or topics


5.8.2 - Instructions for Element 8 XE "Element 8" 

The first screen (8.1) of this element asks if your project will require special training XE "training"  needs or certification XE "certification" . If you select “No” then you will be able to explain why you do not need this. For this exercise select “Yes” and click on the “OK” button.

Question 8.1 asks you to briefly describe the special training XE "training"  that is needed. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 8.2 asks if you will need training XE "training"  or certification XE "certification"  documents. If you choose “Yes” then you will be able to describe them and where they are located. For this exercise select “No” and click on the “OK” button. The next screen asks you to explain why you do not need training or certification documents. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


Question 8.3 asks if you will identify training XE "training"  personnel. If you choose “No” then you will be able to explain why you do not need to identify them. For this exercise select “Yes” and click on the “OK” button. The next screen asks you to briefly describe the kinds of training personnel XE "training personnel"  that will be needed. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue. 


This leads you to Question 8.3.1 where you may list the training XE "training"  courses in tabular format. For this exercise select this option and click on the “OK” button.

Question 8.3.1a asks for the title XE "title"  of the first course. Enter the information and click on the “OK” button. Remember, no commas XE "commas"  may be used in entering any information into comma-delimited XE "comma-delimited"  data. An example could be, “Basic Sampling XE "Sampling"  Techniques” if you wish.

Question 8.3.1b asks for the name of the training XE "training"  provider (the organization). Enter the information and click on the “OK” button. An example could be, “The Sample Training Company” if you wish.


Question 8.3.1c asks who took the training XE "training" . Enter the information and click on the “OK” button. An example could be, “Sampling XE "Sampling"  Team Leaders” if you wish.


Question 8.3.1d asks for the location of the records and certificates from this training XE "training"  course. Enter the information and click on the “OK” button. An example could be, “The Concerned Citizens Organization” if you wish.


Questions 8.3.2a through 8.3.2d repeat the same questions for the second training XE "training"  course. Complete each of the answers as you did previously.


Questions 8.3.3a through 8.3.3d repeat the same questions for the third training XE "training"  course. Complete each of the answers as you did previously.


Click on the “OK” button when you are finished reviewing the displayed draft information.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 6 XE "Element 6"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “8-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the table.


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


After the table has been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.


This completes the work with Element 8 XE "Element 8" .


5.9 Element 9 XE "Element 9"  – Documents and Records

5.9.1 - Content Checklist for Element 9 XE "Element 9" 

In order to complete this section, you will need the following information: 


· A list of all the types of data records XE "data records"  that will be maintained with your project

· A list of to whom you will distribute your approved QAPP copies and how they will be provided to these individuals


· A list of who is responsible for archiving XE "archiving"  each type of data record


· A list of where each type of record will be archived


· A list of how long each type of record will be archived


· A list of how each type of type of record will ultimately be disposed of

5.9.2 - Instructions for Element 9 XE "Element 9" 

The first screen (9.0) of this element asks you to describe who (either a person, organization, or both) will be responsible for maintaining XE "maintaining"  and updating XE "updating"  this QAPP. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  


Question 9.01 asks for a brief description of the general types of data records XE "data records"  that will be maintained as part of your QAPP. You will be able to select specific examples or describe them in your own words with the next questions. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  


Question 9.1 asks for a brief description of the process by which you will distribute copies of an approved QAPP and to whom (person and organization) they will be given. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  


Question 9.2 lists six of the most common types of records that require documentation. The seventh choice “Other” will allow you to provide additional reports that you may plan to document. For this exercise check the boxes for “Field records” and “Analytical laboratory records.” Then click on the “OK” button

Question 9.2.2 asks you to describe your plans for retaining, archiving XE "archiving"  and disposing of field records XE "disposing of field records" . Enter this information and then click on the “OK” button.


Question 9.2 – First Table Input asks if you would like to include your plans for field records in tabular format. Select “Yes” and click on the “OK” button.


Question 9.2.2.1 asks you for the first field record type. Enter “field notebooks XE "field notebooks" ” and click on the “OK” button.

Question 9.2 – Records Retention XE "Records Retention"  asks how long you will retain these records. Since SWAMP recommends at least 8 years then enter that number and click on the “OK” button to continue.


Question 9.2 – Records Archival asks where you will keep these records. Enter the location and click on the “OK” button.

Question 9.2 – Records Disposition asks how you will dispose of them. Enter “shredding” and click on the “OK” button to continue.


Question 9.2 – Another Table Input asks if you want to include another row of information for field records. Select “No” and click on the “OK” button.


Question 9.2.3 asks you to describe your plans for retaining, archiving XE "archiving"  and disposing of laboratory analytical records XE "laboratory analytical records" . Enter this information and then click on the “OK” button.


Question 9.2 – First Table Input asks if you would like to include your plans for laboratory analytical records XE "laboratory analytical records"  in tabular format. Select “No” and click on the “OK” button. This time you will not be asked for tabular input information.


Question 9.3 asks you to identify the individuals and organizations that will be responsible for maintaining XE "maintaining"  each type of project record. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  


Question 9.4 asks for a description of where project records XE "project records"  will be stored, how long, and how they will ultimately be disposed of. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  


Question 9.5 asks for a description of who is responsible for archiving XE "archiving"  each type of project record. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  


Question 9.6 asks whether any of the records will be stored in an electronic format XE "electronic format" . Since this is usually the case, select “Yes” and click on the “OK” button.


Question 9.7 asks for a description of the responsible people XE "responsible people"  and place of storage for electronic records XE "storage for electronic records" . A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  You will next be shown all of your draft answers. 


Click on the “OK” button when you are finished reviewing the displayed draft information.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 6 XE "Element 6"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “9-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then page down to where you see the instructions:


<-------------- Begin Highlighting Table XE "Begin Highlighting Table"  for Formatting Below This Line ------------>


and


<------------- End Highlighting Table XE "End Highlighting Table"  for Formatting Above This Line  --------------->


for the table.


Highlight the text between the two instructions as indicated. 


Hint: if you highlight XE "highlight"  from the bottom right of the text area to the top left of the text area then you will avoid including an extra space at the bottom right in your highlighted area. If you do have an extra space in the bottom right highlighted area then it may sometimes cause an extra empty row to appear in your formatted table. 


After highlighting the text that will be in the table, then click on “Table” in your MS Word toolbar.


Next, select “Convert” from the drop down menu.


Next select “Text to Table XE "Text to Table" ” from the sub-menu.


If you highlighted the table text correctly then you will see a correctly completed “Convert Text to Table XE "Text to Table" ” box in which the bottom row information has “Separate text at” with the “Commas” button selected.


Click on the “OK” button and the comma-delimited XE "comma-delimited"  text will instantly be converted to a “regular” table format.


After the table has been formatted to regular table format XE "regular table format"  then delete the arrows with instructions above and below each table.


This completes the work with Element 9 XE "Element 9" .


5.10 Element 10 XE "Element 10"  – Sampling XE "Sampling"  Process Design

5.10.1 - Content Checklist for Element 10 XE "Element 10" 

In order to complete this section, you will need the following information: 


· The type of sampling stations XE "sampling stations"  planned to be used.

· Why you selected planned sampling stations XE "sampling stations" .


· The reason for your timing selection XE "timing selection" .


· The design principal for reach selection XE "reach selection" .


· The design principal for station selection XE "station selection" .


· The design principal for selection for seasonal selection XE "seasonal selection" .


· The design principal for selection of diurnal selection XE "diurnal selection" .


· On-site observations XE "site observations"  that are planned


· The total number of estimated site visits XE "site visits" . XE "site visits." 

· The frequency XE "frequency"  of visits to sampling stations XE "sampling stations" .


· The time interval between visits to sampling stations XE "sampling stations" .


· Whether or not you plan to use continuous monitoring XE "continuous monitoring"  devices and, if so, what they are.


· A description of what, when and where you plan to visit the sampling area XE "sampling area" .


· A list of potential sources of uncertainty XE "sources of uncertainty"  in your planned data collection.


· A description of important logistics schedule XE "logistics schedule"  information


· A list of critical information XE "critical information"  for your planned project.

5.10.2 - Instructions for Element 10 XE "Element 10" 

The first screen (10.0) of this element asks whether there is one or more than one study question XE "study question" . From Element 5 and 7 exercises you recall that there are two study questions XE "study questions" . One involves field analysis XE "field analysis"  for water quality measurements and the other involves laboratory analysis XE "laboratory analysis"  to try to determine the identification of the source of selected chemical analytes XE "analytes" . However, to save time we are going to combine them in the experimental design of the sampling process. Select “More than one study question” and click the “OK” button. The Advisor lets you know that you need to go through Element 10 XE "Element 10"  questions as many times as there are study questions. Click on the “OK” button to continue.

Question 10.1 asks you to enter the study question XE "study question" . This will be part of a pre-formatted sentence. In the space provided type “water quality of the project’s study area XE "project's study area" ” or any other study question that you wish to enter.


Question 10.2 asks you to identify the types of stations XE "types of stations"  that will be used for sampling. Enter your answer using the information in the right side screen or any other source of information that is appropriate.


Question 10.3 asks why you are selecting the sampling station locations XE "sampling station locations"  that you plan to use. Select an appropriate answer. Based on the study question XE "study question"  “Impact assessment” is one answer that would apply. Click on the “OK” button to continue.

Question 10.4 asks your timing selection XE "timing selection"  intent. Routine monitoring would be one answer that would apply. Please select your answer and click on the “OK” button.

Question 10.5 asks you to select the sampling design principle XE "sampling design principle"  for your reach selection XE "reach selection" . “Directed to the environment” is one answer that could apply. Click on the “OK” button to continue.


Question 10.6 asks you to select the sampling design principle XE "sampling design principle"  for your station selection XE "station selection" . “Directed to the environment” is one answer that could apply. Click on the “OK” button to continue.


Question 10.7 asks you to select the sampling design principle XE "sampling design principle"  for your seasonal selection XE "seasonal selection" . “Directed to the environment” is one answer that could apply. Click on the “OK” button to continue.


Question 10.8 asks you to select the sampling design principle XE "sampling design principle"  for your diurnal selection XE "diurnal selection" . “Systematic” is one answer that could apply. Click on the “OK” button to continue.


Question 10.9 asks you to describe what on-site observations XE "site observations"  or other relevant measurements you plan to record. A useful example in the right side screen may be copied and pasted, after appropriate edits for your plans, in the space provided in the left side screen. Click on the “OK” button to continue.  

Question 10.10 asks you to enter the number of site visits XE "site visits"  you plan to make. You may enter just a number if you wish – your entry will complete a pre-formatted sentence. Click on the “OK” button to continue.


Question 10.11 asks for you to enter the frequency XE "frequency"  at which the sampling stations XE "sampling stations"  will be visited. Using the information in the right side screen enter your answer and click on the “OK” button to continue.


Question 10.12 asks you to enter the planned interval between your visits. Using the information in the right side screen enter your answer and click on the “OK” button to continue.


Question 10.13 asks you to describe your continuous monitoring XE "continuous monitoring"  devices or, if you do not plan to use them then state that decision. Click the “OK” button to continue.


Question 10.14 asks you to provide a brief work statement XE "work statement"  of who will do what, when and where. Some examples are provided in the right side screen. Enter your answer and click on the “OK” button.


Question 10.15 asks you to provide a brief statement of potential sources of uncertainty XE "sources of uncertainty" . Useful information is provided in the right side screen. Enter your answer and click on the “OK” key.


Question 10.16 asks you to identify important logistics schedules. This information is typically found in your monitoring plan and you may reference that document or enter your own information. Then click on the “OK” button to continue.


Question 10.17 asks you to list what information is critical to your study and what is for informational purposes only. Enter this information and then click on “OK” button. A draft of your answers will immediately be presented for your review.

When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 10 XE "Element 10"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “10-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then Question 10.18 asks if you want to loop through the questions again for another study question XE "study question" . Since there are two study questions XE "study questions"  involved in this example exercise, and you have just completed the first one, select “Yes” and you will loop though the same 17 questions again. Change those that are applicable for laboratory analysis XE "laboratory analysis"  of analytes XE "analytes"  to determine the source identification of them.

Again you will be presented with a review of your second draft information. When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 10 XE "Element 10"  and send it to your browser XE "browser" . 

Click on the “File” tab in the MS Word file, select “Save As” but DO NOT NAME THIS SECOND STUDY QUESTION FILE 10-QAPP. The reason is that you have already saved the document file from the first study question XE "study question"  by that name and if you use it again you will copy over the first file. Instead, name this file, “10a-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.

Remember that you will have to copy and paste the information from this file into your Master QAPP XE "Master QAPP"  document because the macro XE "macro"  in your CoverPage.doc XE "CoverPage.doc"  file was not instructed to find multiple files for a given element to append.  This feature will be added, if possible, in the future.


You will be returned to Question 10.18. This time choose “No, I am finished” and click on the “OK” button. 


This completes the work with Element 10 XE "Element 10" 

5.11 Element 11 XE "Element 11"  – Sampling XE "Sampling"  Methods

5.11.1 - Content Checklist for Element 11 XE "Element 11" 

In order to complete this section, you will need the following information: 


· A summary of plans for collecting samples XE "plans for collecting samples"  of water, sediment XE "sediment"  and tissue XE "tissue"  as applicable.

· A summary of sterilization of containers XE "containers" , or their commercial source, if applicable.


· A summary of field sample preparations XE "sample preparations"  or manipulations if applicable.


· A list of sample containers XE "containers"  and their volumes for all media XE "media"  sampled.


· A summary of sample preparation plans for all media XE "media"  sampled.


· A summary of container cleaning XE "container cleaning"  plans, or their commercial source, if applicable.


· A summary of plans for sample labeling XE "labeling"  for all sample containers XE "containers" .


· A list of any sampling equipment XE "sampling equipment"  and its cleaning XE "cleaning"  procedures if applicable.


· A summary of plans for disposing of sampling equipment XE "sampling equipment"  cleaning XE "cleaning"  byproducts XE "byproducts"  if applicable.


· A summary of corrective actions XE "corrective actions" , and person(s) responsible if sampling problems occur.


· A list of SOPs XE "SOPs"  that apply to sampling methods XE "sampling methods" .

5.11.2 - Instructions for Element 11 XE "Element 11" 

The first screen 11.0 asks you to select which of three U.S. EPA-defined “media XE "media" ” you plan to sample (water, air, and/or sediment XE "sediment" ). Select all three media for this exercise and click on the “OK” button.

Question 11.1.1 asks you to briefly summarize your plans for collecting water samples XE "water samples" . Advice and information, including links XE "links"  to the SWAMP Field Methods Course XE "Field Methods Course"  (a tutorial with slides and audio) is provided in the right side screen. Please enter your information or, if it is in your Monitoring Plan XE "Monitoring Plan" , reference that source and then click on the “OK” button.

Question 11.5 asks if sterile XE "sterile"  containers XE "containers"  will be used. Select “Yes” and click on the “OK” button.


Question 11.5.1 asks whether you will purchase sterile XE "sterile"  containers XE "containers"  or sterilize them yourself and, whatever the case, to describe how you can be certain that they are sterile. The right side screen contains useful information for answering this question. After entering your response then click on the “OK” button.


Question 11.1.2 asks you to briefly summarize your plans for collecting sediment XE "sediment"  samples. Advice and information, including links XE "links"  to the SWAMP Field Methods Course XE "Field Methods Course"  is provided in the right side screen. Please enter your information or, if it is in your Monitoring Plan XE "Monitoring Plan" , reference that source and then click on the “OK” button.


Question 11.1.3 asks you to briefly summarize your plans for collecting tissue XE "tissue"  samples. Advice and information, including links XE "links"  to SWAMP method requirements from the SWAMP web site is provided in the right side screen. Please enter your information or, if it is in your Monitoring Plan XE "Monitoring Plan" , reference that source and then click on the “OK” button.


Question 11.2 asks whether any samples will be processed or prepared in the field. Select “Yes” to this question and click on the “OK” button.


Question 11.2.1 asks you to describe what field preparations XE "field preparations"  or manipulations will be conducted (and on samples from which media XE "media" ). Please enter your information and click on the "OK" button.

Question 11.3 asks you to describe each kind of container and sample volumes XE "sample volumes"  for each media XE "media"  that will be sampled. Note that important information is provided in the right side screen (including a link to text that you may copy and paste). Please enter your information and click on the "OK" button.

Question 11.4 asks if any of your samples will be preserved – this includes cooling XE "cooling"  samples. Select “Yes” and click on the "OK" button.

Question 11.4.1 asks you to describe all of your sample preservation XE "sample preservation"  plans. Note that the information in the right side screen advises that you may reference the information in Table 12.1 that was automatically generated for you in Element 7 XE "Element 7" . Please enter your information and click on the "OK" button.


Question 11.5.2 asks you to describe your sample container cleaning XE "container cleaning"  procedures. If you plan to use pre-cleaned commercial containers XE "containers"  then provide the name of their source. Please enter your information and click on the "OK" button.


Question 11.6 asks you to describe your procedure to ensure unique sample number XE "sample number"  labels XE "labels" . Please enter your information and click on the "OK" button.


Question 11.7 asks whether sampling equipment XE "sampling equipment"  will be used to help you gather samples. Select “Yes” and click on the "OK" button.


Question 11.7.1 asks you to list sampling equipment XE "sampling equipment"  that will be used and how you plan to clean it. Review the information available in the right side screen link for ideas, enter your answer in the space provided in the left screen and click on the "OK" button to continue.


Question 11.7.2 is a result of your answer to questions 11.7 and 11.7.1 because if you clean sampling equipment XE "sampling equipment"  then you will have byproducts XE "byproducts"  of this process to dispose of. Click on the link in the right side screen to help you formulate your answer – you may find that some of the text may be copied and pasted with appropriate edits. Enter your answer in the space provided in the left screen and click on the "OK" button to continue.


Question 11.8 asks for a description of the corrective actions XE "corrective actions"  to be followed if sampling problems occur. Click on the link in the right side screen to help you formulate your answer – you may find that some of the text may be copied and pasted with appropriate edits. Enter your answer in the space provided in the left screen and click on the "OK" button to continue.


Question 11.9 asks for a list of SOPs XE "SOPs"  that involve sampling methods XE "sampling methods" . If you have this information referenced in your Monitoring Plan XE "Monitoring Plan"  you may refer to it here or enter your answer in the space provided in the left screen and click on the "OK" button to continue.


Question 11.10 alerts you to the fact that you are finished entering information into Element 11 XE "Element 11" . Select “Yes” and click on the "OK" button to review your draft answers.

When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 11 XE "Element 11"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “11-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 11 XE "Element 11" .


5.12 Element 12 XE "Element 12"  – Sample Handling and Custody

5.12.1 - Content Checklist for Element 12 XE "Element 12" 

In order to complete this section, you will need the following information: 


· Your Monitoring Plan XE "Monitoring Plan"  to refer to procedures that you have documented for sample handling and custody XE "custody" .

5.12.2 - Instructions for Element 12 XE "Element 12" 

The first screen 12.1 asks for the name of the person with ultimate responsibility for sample handing XE "sample handing"  and custody XE "custody" . Enter that person’s name and click on the "OK" button.

Question 12.1.1 asks you to select how sample handling information will be documented. Click on the link in the right side screen to view the pre-formatted text. Then select “Both field notebooks XE "field notebooks"  and forms will be used” and click on the "OK" button.


Question 12.2 asks if chain-of-custody XE "custody"  forms will be used. These are necessary for a SWAMP-Comparable XE "SWAMP-Comparable"  QAPP. Click on the link in the right side screen to see the pre-formatted text. Then select “Yes” and click on the "OK" button.


Question 12.3 asks if the laboratory will use chain-of-custody XE "custody"  procedures to track samples. These are necessary for a SWAMP-Comparable XE "SWAMP-Comparable"  QAPP. Click on the link in the right side screen to see the pre-formatted text. Then select “Yes” and click on the "OK" button.


Question 12.4 asks if samples will be packed in ice and cooled. This is necessary for a SWAMP-Comparable XE "SWAMP-Comparable"  QAPP. Click on the link in the right side screen to see the pre-formatted text. Then select “Yes” and click on the "OK" button.


Question 12.5 asks if shipping containers XE "containers"  will be prepared and sealed according to SWAMP recommendations. This is necessary for a SWAMP-Comparable XE "SWAMP-Comparable"  QAPP. Click on the link in the right side screen to see the pre-formatted text. Then select “Yes” and click on the "OK" button.


Question 12.6 asks how samples will be transported to the laboratory. Click on the link in the right side screen to see the pre-formatted text. Then select your answer and click on the "OK" button.


Question 12.7 alerts you to the fact that you are finished entering information into Element 12 XE "Element 12" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 12 XE "Element 12"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “12-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 12 XE "Element 12" .


5.13 Element 13 XE "Element 13"  – Method Selection

5.13.1 - Content Checklist for Element 13 XE "Element 13" 

In order to complete this section, you will need the following information: 


· The name of the laboratory that will conduct analyses XE "analyses"  on the planned samples.


· A description of the methods that are planned to be used and information from your Monitoring Plan XE "Monitoring Plan"  concerning your sampling stations XE "sampling stations" .

· A copy of the laboratory’s SOP for handling and documenting method failures.


· A list of turn around times XE "turn around times"  for various planned sample analyses XE "analyses" .


· A description of how the laboratory handles its waste from your samples including a reference to the lab’s SOP.

5.13.2 - Instructions for Element 13 XE "Element 13" 

The first screen (13.1) asks whether either in-situ or continuous monitoring XE "continuous monitoring"  procedures will be used. Select “Yes” and click on the "OK" button.


Question 13.1.1 asks which of the two will be used. Check both of the boxes and click on the "OK" button.

Question 13.1.1A asks if there are any known physical impediments XE "impediments"  to obtaining representative data XE "representative data"  from sampling stations XE "sampling stations"  where in-situ sampling will be conducted. Select “No” and click on the "OK" button.


Question 13.1.1B asks if here are any known physical impediments XE "impediments"  to obtaining representative data XE "representative data"  from sampling stations XE "sampling stations"  where continuous sampling XE "continuous sampling"  will be conducted. Select “No” and click on the "OK" button.


Question 13.2 asks if there are any field methods XE "field methods"  that will be used that were not already included in Table 13.1 (which was automatically generated in Element 7 XE "Element 7" )? Select “No” and click on the "OK" button.


Question 13.3 asks that you insert the name of the laboratory that will conduct the proposed analyses XE "analyses" . Enter the lab’s name and click on the "OK" button.

Question 13.4 asks if there are any laboratory methods XE "laboratory methods"  that will be used that were not already included in Table 13.2 (which was automatically generated in Element 7 XE "Element 7" )? Select “No” and click on the "OK" button.


Question 13.5 asks if there will be any modified methods XE "modified methods"  that will be used. Click on the link in the right side screen to view the pre-formatted text for the situation in which no modified methods are planned and then select “Unmodified promulgated methods will be used” and click on the "OK" button.


Question 13.6 asks you to enter the person’s name who will be responsible for corrective action XE "corrective action"  if a laboratory method fails to perform as needed. Enter the name and click on the "OK" button.

Question 13.6.1 asks for a summary of the procedures that the laboratory has in place and that will be used in the event of method failure XE "method failure" . Click on the link in the right side screen to view text that you may copy and paste, with appropriate  edits. Enter your answer in the left side screen and click on the "OK" button.


Question 13.6.2 asks for a summary of the documentation procedures XE "documentation procedures"  that the laboratory has in place and that will be used in the event of method failure XE "method failure" . Click on the link in the right side screen to view text that you may copy and paste, with appropriate edits. Enter your answer in the left side screen and click on the "OK" button.


Question 13.7 asks for a summary of how the laboratory manages disposal of its wastes XE "wastes" . Click on the link in the right side screen to view text that you may copy and paste, with appropriate edits. Enter your answer in the left side screen and click on the "OK" button.


Question 13.8.1 asks for a summary of the turn around time XE "turn around time"  needed for sample analysis. Click on the link in the right side screen to view text that you may copy and paste, with appropriate edits. Enter your answer in the left side screen and click on the "OK" button.


Question 13.8.2 asks you to select the status of your discussions about turn around time XE "turn around time"  with the laboratory. Select the appropriate answer and click on the "OK" button.


Question 13.9 alerts you to the fact that you are finished entering information into Element 13 XE "Element 13" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 13 XE "Element 13"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “13-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 13 XE "Element 13" .


5.14 Element 14 XE "Element 14"  – Quality Control

5.14.1 - Content Checklist for Element 14 XE "Element 14" 

In order to complete this section, you will need the following information: 


· A list of the types of quality control XE "quality control"  samples XE "quality control samples"  needed for your project.

5.14.2 - Instructions for Element 14 XE "Element 14" 

The first screen (14.1) asks if there are additional measurement parameters and quality control XE "quality control"   (QC)  data other than those automatically generated in Element 7 XE "Element 7"  and placed in Table 14.1. Read the pre-formatted text from the link in the right side screen. Select “No” and click on the "OK" button.

Question 14.2 asks if you would like the SWAMP Advisor to add pre-formatted text with additional QC samples XE "QC samples"  that you plan to use versus your own written descriptions. Read the pre-formatted text from the link in the right side screen. Select “Yes” and click on the "OK" button.


Question 14.2.1 provides a menu with eleven commonly used types of QC samples XE "QC samples" . Select all that apply and click on the "OK" button. Pre-formatted text shown from the link on the right side screen will automatically be inserted into your text document for each type of QC sample selected.


Question 14.3 asks if one of your objectives is to determine whether the analytes XE "analytes"  being monitored are in “elevated” concentrations over “normal” environmental concentrations. Click on the link to read the pre-formatted text, then select “Yes” and click on the "OK" button.

Question 14.4 alerts you to the fact that you are finished entering information into Element 14 XE "Element 14" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 14 XE "Element 14"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “14-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 14 XE "Element 14" .


5.15 Element 15, 16, & 17 – Inspection, Calibration, and Supplies

5.15.1 - Content Checklist for Elements 15, 16, & 17

In order to complete this section, you will need the following information: 


· A list of people who will be responsible for testing XE "testing"  instruments XE "instruments"  and field equipment XE "field equipment" , for calibration XE "calibration"  of laboratory instruments XE "laboratory instruments" , and for inspection and acceptance of supplies XE "supplies"  and consumables XE "consumables" .

5.15.2 - Instructions for Elements 15, 16, & 17

The first screen (15.1) asks if you plan to include field measurements XE "field measurements"  with your project. Click on the link in the right side screen, read the pre-formatted text. Then select “Yes” and click on the "OK" button.

Question 15.1B asks for the name of the person who will be responsible for instrument and equipment testing XE "testing"  for field measurements XE "field measurements" . Enter the person’s name and click on the "OK" button.


Question 16.1 lists eight commonly measured field parameters XE "field parameters" . Click on the link in the right side screen to read the pre-formatted text. Then check all that apply and click on the "OK" button.


Question 15.2 asks if laboratory measurements XE "laboratory measurements"  will be made. Click  on  the link on the right side screen to read the pre-formatted text. Then select “Yes” and click on the "OK" button.


Question 16.1B asks you to name the person who will be responsible for instrument and equipment calibration XE "calibration"  at the necessary frequencies. Enter the name(s) and click on the "OK" button.

Question 16.2 provides a menu of common parameters that are measured in the laboratory. Click on the link in the right side screen to read the pre-formatted text. Check all that apply and click on the "OK" button.


Question 15.3 asks if you plan to measure biological organisms XE "organisms"  (bacteria XE "bacteria"  and/or benthic XE "benthic"  organisms). Click on the link in the right side screen to read the pre-formatted text and then select “Yes” and click on the "OK" button.


Question 16.3 asks you to select which types of biological organisms XE "organisms"  you plan to monitor. Click on the link in the right side screen to read the pre-formatted text. Check all that apply and click on the "OK" button. 


Question 17.1 asks if there are any critical supplies XE "supplies"  with your planned project. Click on the link in the right side screen to read the pre-formatted text. Select “Yes” and click on the "OK" button.

Question 17.1B results from your selection of “Yes” in the previous question. Enter the name of the person who will be responsible for inspection and acceptance of supplies XE "supplies"  and consumables XE "consumables"  and click on the "OK" button.


Question 17.2 alerts you to the fact that you are finished entering information into Elements 15, 16, and 17 XE "Elements 15, 16, and 17" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Elements 15, 16, and 17 XE "Elements 15, 16, and 17"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “151617-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Elements 15, 16, and 17 XE "Elements 15, 16, and 17" .

5.16 Element 18 XE "Element 18"  – External Data

5.16.1 - Content Checklist for Element 18 XE "Element 18" 

In order to complete this section, you will need the following information: 


· A list of sources of external data XE "external data"  that will be used.

· Name of the projects from which external data XE "external data"  will be used.


· Acceptance criteria XE "Acceptance criteria"  for using external data XE "external data" .


· Limits on data that fail acceptance criteria XE "acceptance criteria" .


· Any constraints XE "constraints"  on using external data XE "external data" .


5.16.2 - Instructions for Element 18 XE "Element 18" 

The first screen (18.1) asks if you know where your external data XE "external data"  will come from. Read the pre-formatted text in the right side screen, select “Yes,” and click on the "OK" button.

Question 18.1.1 provides a menu with 8 typical sources of external data XE "external data"  and “Other sources” (which allows you to describe your own source). Click on the link in the right side screen to read the pre-formatted text and then select “Existing data from a previous effort” and click on the "OK" button.

Question 18.1.7 asks you to name the project and summarize the data that you will use. Enter the requested information and click on the "OK" button.


Question 18.2 asks how you plan to use the external data XE "external data" . Enter the requested information and click on the "OK" button.


Question 18.3 asks what kinds of acceptance criteria XE "acceptance criteria"  will be used to accept external data XE "external data"  for use on the planned project. Click on the link in the right side screen to read the pre-formatted text, check all answers that apply, and click on the "OK" button.


Question 18.4 asks what limits XE "limits"  will be put on data that fail your acceptance criteria XE "acceptance criteria" . Click on the link in the right side screen to read the pre-formatted text, check all answers that apply, and click on the "OK" button.


Question 18.5 asks if there are any constraints XE "constraints"  on your ability to obtain and use the external data XE "external data" . Click on the link in the right side screen to read the pre-formatted text, select “No,” and click on the "OK" button.


Question 18.6 asks if there are any key resources XE "key resources" , equipment or facilities that would inhibit your ability to use the external data XE "external data" . Click on the link in the right side screen to read the pre-formatted text, select “No,” and click on the "OK" button.


Question 18.7 alerts you to the fact that you are finished entering information into Element 18 XE "Element 18" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 18 XE "Element 18"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “18-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 18 XE "Element 18" .

5.17 Element 19 XE "Element 19"  – Data Management

5.17.1 - Content Checklist for Element 19 XE "Element 19" 

In order to complete this section, you will need the following information: 


· SOPs XE "SOPs"  for field data XE "field data"  management, continuous measurement data management XE "data management" , and laboratory data XE "laboratory data"  management.

5.17.2 - Instructions for Element 19 XE "Element 19" 

The first screen (19.0) provides a menu to select which types of measurements you will need data management XE "data management"  for. For this exercise please select all three and click on the "OK" button.

Question 19.1.0 asks if you have a SOP for field data XE "field data"  management. Select “Yes” and click on the "OK" button.


Question 19.1.0A asks you to type the title XE "title"  and SOP reference number XE "SOP reference number" . Note that this information will be appended to the end of the sentence shown in the right side screen and inserted into your text document. After your entry is made then click on the “OK” button to continue.


Question 19.1.1 asks if the SOP describes what standard practices will be used for record keeping XE "record keeping"  and data tracking XE "data tracking"  of field data XE "field data" . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.1.2 asks if your SOP identifies data handing equipment XE "data handing equipment"  and/or procedures for processing, analyzing, compiling XE "compiling" , and/or transmitting XE "transmitting"  field analytical data XE "field analytical data" . on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.1.3 asks if your SOP describes how field measurement data XE "field measurement data"  will be formatted and entered (or prepared for uploading) into the SWMP Information Management System XE "Information Management System" . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.1.4 asks if your SOP conforms to the SWAMP Information Management System XE "Information Management System"  requirements for using standardized data sheets. Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.1.5 asks you to enter the name of the person who will be responsible for management of the field data XE "field data" . Note that this name will be appended to the sentence shown in the right side screen. Enter the person’s name and click on the "OK" button.


Question 19.2.0 asks if you have a SOP for continuous monitoring XE "continuous monitoring"  data management XE "data management" . Select “Yes” and click on the "OK" button.


Question 19.2.0A asks you to type the title XE "title"  and SOP reference number XE "SOP reference number" . Note that this information will be appended to the end of the sentence shown in the right side screen and inserted into your text document. After your entry is made then click on the “OK” button to continue.


Question 19.2.1 asks if the SOP describes what standard practices will be used for record keeping XE "record keeping"  and data tracking XE "data tracking"  of continuous monitoring XE "continuous monitoring"  data. Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.2.2 asks if your SOP identifies data handing equipment XE "data handing equipment"  and/or procedures for processing, analyzing, compiling XE "compiling" , and/or transmitting XE "transmitting"  continuous monitoring XE "continuous monitoring"  data. on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.2.3 asks if your SOP describes how continuous monitoring XE "continuous monitoring"  data will be formatted and entered (or prepared for uploading) into the SWMP Information Management System XE "Information Management System" . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.2.4 asks if your SOP conforms to the SWAMP Information Management System XE "Information Management System"  requirements for using standardized data sheets. Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.2.5 asks you to enter the name of the person who will be responsible for management of the continuous monitoring XE "continuous monitoring"  data. Note that this name will be appended to the sentence shown in the right side screen. Enter the person’s name and click on the "OK" button.


Question 19.3.0 asks if you have a SOP for laboratory data XE "laboratory data"  management XE "data management" . Select “Yes” and click on the "OK" button.


Question 19.3.0A asks you to type the title XE "title"  and SOP reference number XE "SOP reference number" . Note that this information will be appended to the end of the sentence shown in the right side screen and inserted into your text document. After your entry is made then click on the “OK” button to continue.


Question 19.3.1 asks if the SOP describes what standard practices will be used for record keeping XE "record keeping"  and data tracking XE "data tracking"  of laboratory data XE "laboratory data" . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.3.2 asks if your SOP identifies data handing equipment XE "data handing equipment"  and/or procedures for processing, analyzing, compiling XE "compiling" , and/or transmitting XE "transmitting"  laboratory analytical data XE "laboratory analytical data" . on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.3.3 asks if your SOP describes how field measurement data XE "field measurement data"  will be formatted and entered (or prepared for uploading) into the SWMP Information Management System XE "Information Management System" . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.3.4 asks if your SOP conforms to the standardized list XE "standardized list"  of analytes XE "analytes"  necessary to meet the requirements of the SWAMP Information Management System XE "Information Management System" . Click on the links XE "links"  to additional information if you need it. Also, click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.3.5 asks you to select whether you SOP covers only chemical and/or biological analytes XE "analytes"  or only toxicology tests XE "toxicology tests"  or both. . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Chemical and/or bacteria XE "bacteria"  and also toxicity” and click on the "OK" button.


Question 19.3.5.1 asks if your SOP conforms to the SWAMP Management Information System Analytical Data Template. Click on the links XE "links"  to additional information if you need it. Also, click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.3.5.2 asks if your SOP conforms to the SWAMP Management Information System Toxicity Analysis Data Template XE "Toxicity Analysis Data Template"  and Toxicity Data Format XE "Toxicity Data Format" . Click on the links XE "links"  to additional information if you need it. Also, click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.3.6 asks you to enter the name of the person who will be responsible for management of the laboratory data XE "laboratory data" . Note that this name will be appended to the sentence shown in the right side screen. Enter the person’s name and click on the "OK" button.


Question 19.4 asks if your SOP conforms to the SWAMP Information Management System XE "Information Management System"  required fields in the station template XE "station template" . Click on the links XE "links"  to additional information if you need it. Also, click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.5 asks if your SOP conforms to the SWAMP Information Management System XE "Information Management System"  file and batch name convention XE "batch name convention" . Click on the links XE "links"  to additional information if you need it. Also, click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.6 asks if your SOP conforms to the SWAMP Information Management System XE "Information Management System"  requirements for specified fields for database comparability XE "database comparability" . Click on the links XE "links"  to additional information if you need it. Also, click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Yes” and click on the "OK" button.


Question 19.7 asks whether form entry XE "form entry"  or batch loading XE "batch loading"  or both will be used to upload data XE "upload data"  into the SWAMP Information Management System XE "Information Management System" . Click on the link in the right side screen to view the pre-formatted text that will be inserted into your text document, select “Both” and click on the "OK" button.


Question 19.8 alerts you to the fact that you are finished entering information into Element 19 XE "Element 19" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 19 XE "Element 19"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “19-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 19 XE "Element 19" .

5.18 Element 20 XE "Element 20"  – Assessment and Response

5.18.1 - Content Checklist for Element 20 XE "Element 20" 

In order to complete this section, you will need the following information: 


· SOPs XE "SOPs"  for field assessments XE "field assessments"  and laboratory assessments XE "laboratory assessments"  with descriptions of who will conduct them, when they will be conducted, how often they will be conduced, what they will cover, and how any deficiencies XE "deficiencies"  found will be documented and corrected

5.18.2 - Instructions for Element 20 XE "Element 20" 

The first screen (20.0) provides a short menu of the types of assessments that you plan with the proposed project. Select both of them and click on the "OK" button.

Question 20.1 provides a short menu of the types of field assessments XE "field assessments"  that you plan to make. Select all of them and click on the "OK" button.


Question 20.1.1.1 asks for the name of the responsible person for readiness reviews XE "readiness reviews"  for field assessments XE "field assessments" . Enter the person’s name and click on the "OK" button.


Question 20.1.1.2 asks you to describe when and/or how often readiness reviews XE "readiness reviews"  will be conducted. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.

Question 20.1.1.3 provides 4 typical types of readiness reviews XE "readiness reviews" . Click on the right side link to read each of the pre-formatted answers and then check all that apply and click on the "OK" button.


Question 20.1.1.4 asks for a description of how any problems that were noted during readiness reviews XE "readiness reviews"  will be documented and corrected, including who will be responsible for corrections XE "corrections"  and documenting them. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.2.1 asks for the name of the person who will be responsible for field activity audits XE "field activity audits" . Enter that person’s name and click on the "OK" button.


Question 20.1.2.2 asks for a description of when and/or how often field activity audits XE "field activity audits"  will be made. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.2.3.asks for a description of what types of procedures will be included in field activity audits XE "field activity audits" . . Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.2.4 asks for a description of how any problems that were noted during field activity audits XE "field activity audits"  will be documented and corrected, including who will be responsible for corrections XE "corrections"  and documenting them. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.2.5 asks for the name of the person who has responsibility to stop sampling XE "stop sampling"  activities in the event that a serious problem makes that a necessity and under what conditions that authority could be used. Enter the person’s name and click on the "OK" button.


20.1.3.1 asks for the name of the person who will be responsible for conducting post sampling event XE "post sampling event"  reviews XE "reviews" . Enter that person’s name and click on the "OK" button.


Question 20.1.3.2 asks for a description of when and/or how often post sampling event XE "post sampling event"  reviews XE "reviews"  will be made. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.3.3.asks for a description of what types of information will be included in post sampling event XE "post sampling event"  reviews XE "reviews" . Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.3.4 asks for a description of how any problems that were noted during post sampling event XE "post sampling event"  reviews XE "reviews"  will be documented and corrected, including who will be responsible for corrections XE "corrections"  and documenting them. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.2 provides a short menu of the types of laboratory assessments XE "laboratory assessments"  that you plan to make. Select both of them and click on the "OK" button.

Question 20.2.1.1 asks for the name of the responsible person for reviews XE "reviews"  of laboratory analytical data XE "laboratory analytical data" . Enter the person’s name and click on the "OK" button.


Question 20.2.1.2 asks you to describe when and/or how often laboratory analytical data XE "laboratory analytical data"  reviews XE "reviews"  will be conducted. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.2.1.3 asks for a description of how any problems that were noted during laboratory analytical data XE "laboratory analytical data"  reviews XE "reviews"  will be documented and corrected, including who will be responsible for corrections XE "corrections"  and documenting them. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.2.1.4 asks for the name of the person who has responsibility to request re-tests of laboratory analyses XE "analyses"  in the event that a serious problem makes that a necessity and under what conditions that authority could be used. Enter the person’s name and click on the "OK" button.


Question 20.2.2.1 asks for the name of the person who will be responsible for conducting laboratory audits XE "laboratory audits" . Enter that person’s name and click on the "OK" button.


Question 20.2.2.2 asks for a description of when and/or how often laboratory audits XE "laboratory audits"  will be made. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.2.2.3 asks for a description of how any problems that were noted during laboratory audits XE "laboratory audits"  will be documented and corrected, including who will be responsible for corrections XE "corrections"  and documenting them. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.1.3.4 asks for a description of any relative laboratory proficiency tests XE "proficiency tests"  that are planned. Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 20.3 alerts you to the fact that you are finished entering information into Element 20 XE "Element 20" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 20 XE "Element 20"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “20-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 20 XE "Element 20" .

5.19 Element 21 XE "Element 21"  – Reports to Management

5.19.1 - Content Checklist for Element 21 XE "Element 21" 

In order to complete this section, you will need the following information: 


· A list of all the reports to management XE "reports to management"  that you plan to prepare.

· A list of who will be responsible for each type of report.


· A list of when each report will be distributed.


· A list of to whom each type of report will be distributed.

5.19.2 - Instructions for Element 21 XE "Element 21" 

The first screen (21.0) provides a list of 8 common types of reports to management XE "reports to management"  plus “Other” which allows you to enter your own report description. For each report type that you select you will be asked to provide specific information about who will be responsible for it, when it will be distributed, and to whom it will be distributed. Therefore, for this exercise select only two reports: #1 – Final Report and #4 Monthly Status Reports. Check each of these and click on the "OK" button.


Question 21.1 asks you to provide details about submitting the final report to management.  Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 21.4 asks you to provide details about submitting the monthly reports to management XE "reports to management" .  Useful information, that you may copy and paste with appropriate edits, is provided in the right side screen. Enter your answer and click on the "OK" button.


Question 21.10 alerts you to the fact that you are finished entering information into Element 21 XE "Element 21" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 21 XE "Element 21"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “21-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 21 XE "Element 21" .

5.20 Element 22 XE "Element 22"  – Data Review, Verification, and Validation

5.20.1 - Content Checklist for Element 22 XE "Element 22" 

In order to complete this section, you will need the following information: 


· A list of people who will have primary responsibility for data review XE "data review" , data verification XE "data verification"  and data validation XE "data validation" .

· SOP for data review XE "data review" .

· SOP for data verification XE "data verification" .

· SOP for data validation XE "data validation" .

· A list of Measurement Quality Objectives XE "Measurement Quality Objectives"  from Element 7 XE "Element 7" .


· A list of QA/QC XE "QA/QC"  requirements from Elements 14, 15, 16, and 17.

5.20.2 - Instructions for Element 22 XE "Element 22" 

The first question (22.1) asks if you plan to conduct a review of the data from the proposed project. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.

Question 22.2.1 asks for the name of the person who will be responsible for data review XE "data review" . Enter the person’s name in the space provided and click on the "OK" button.


Question 22.1.2 asks if the data review XE "data review"  will include typical kinds of error checks. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.1.3 asks if the data will be reviewed against the Method Quality Objectives that were documented in Element 7 XE "Element 7" . Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.1.4 asks if the data will be reviewed against the QA/QC XE "QA/QC"  requirements that were documented in Elements 14, 15, 16, and 17. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.1.5 asks if the data will include checking field sampling and measurement data. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.1.6 asks if the data will include checking laboratory analytical data XE "laboratory analytical data" . Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.2 asks if you plan to conduct data verification XE "data verification" . Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.2.1 asks for the name of the person who will be responsible for data verification XE "data verification" . Enter the person’s name in the space provided and click on the "OK" button.


Question 22.3 asks if you plan to conduct data validation XE "data validation" . Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.3.1 asks for the name of the person who will be responsible for data validation XE "data validation" . Enter the person’s name in the space provided and click on the "OK" button.


Question 22.4 asks if you plan to separate the data into categories XE "categories"  that can be used to make decisions. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 22.5 alerts you to the fact that you are finished entering information into Element 22 XE "Element 22" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 22 XE "Element 22"  and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “22-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 22 XE "Element 22" .

5.21 Element 23 – Verification and Validation Methods

5.21.1 - Content Checklist for Element 23

In order to complete this section, you will need the following information: 


· A list of people who will be responsible for data reviews XE "reviews"  and laboratory data XE "laboratory data"  reviews.

· A list of people who will be responsible for independently reviewing XE "independently reviewing"  at least 10% of the data and laboratory data XE "laboratory data" .

5.21.2 - Instructions for Element 23

The first question (23.1) asks if many of the details of data verification XE "data verification"  and validation were covered in Element 22 XE "Element 22" . Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 23.2 asks if all data records XE "data records"  will be inspected visually and recorded as checked by initials and dates. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 23.2.1 asks for the name of the person who will be responsible for the data reviews XE "reviews" . Enter the person’s name and click on the "OK" button.


Question 23.2.2 asks if at least 10% of the data will be independently checked XE "independently checked" . Click on “Yes” and click on the "OK" button.


Question 23.2.3 asks for the name of the person who will be responsible for independently reviewing XE "independently reviewing"  the data. Enter the person’s name and click on the "OK" button.


Question 23.3 asks if the laboratory will check all of its data. Click on the link in the right side screen to read the pre-formatted text, click on “Yes” and click on the "OK" button.


Question 23.3.1 asks for the name of the person who will be responsible for reviewing all of the laboratory data XE "laboratory data" . Enter the person’s name and click on the "OK" button.


Question 23.3.2 asks if at least 10% of the laboratory data XE "laboratory data"  will be independently checked XE "independently checked" . Click on “Yes” and click on the "OK" button.


Question 23.3.3 asks for the name of the person who will be responsible for independently reviewing XE "independently reviewing"  the laboratory data XE "laboratory data" . Enter the person’s name and click on the "OK" button.


Question 23.4 asks for a description of how errors XE "errors"  that involve data verification XE "data verification"  and validation will be handled and documented if any should be found. Click on the link in the right side screen to view useful information that may be copied and pasted, with appropriate modifications. Enter your answer in the left side screen and click on the "OK" button.


Question 23.4.1 asks for the name of the person who will be responsible for reporting and correcting any errors XE "errors"  that may be found in the data. Enter the person’s name and click on the "OK" button.


Question 23.5 asks for a description of how any data quality issues XE "data quality issues"  that may develop during the project will be resolved. Click on the link in the right side screen to view useful information that may be copied and pasted, with appropriate modifications. Enter your answer in the left side screen and click on the "OK" button.


Question 23.5.1 asks for the name of the person who will be responsible for resolving any issues that may be found during the verification and validation process. Enter the person’s name and click on the "OK" button.


Question 23.6 asks if there are any SOPs XE "SOPs" , checklists, special equations, etc. that will be appended to the QAPP. If there are you will be able to list them in a following question. Select “No” and click on the "OK" button.

Question 23.7 alerts you to the fact that you are finished entering information into Element 23. XE "Element 23."  Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 23 and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “23-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 23. XE "Element 23." 

5.22 Element 24 XE "Element 24"  – Reconciliation With User Requirements

5.22.1 - Content Checklist for Element 24 XE "Element 24" 

In order to complete this section, you will need the following information: 


· A printed copy of your draft QAPP document files from Elements 1 – 23.

5.22.2 - Instructions for Element 24 XE "Element 24" 

The first question (24.1) asks you to reiterate your project’s objectives. This is a restatement of your answer in Element 5.1. You may copy that statement from your 5-QAPP.rtf document into the space in the left side screen or retype it. Additionally, an example from the Sycamore Creek XE "Sycamore Creek"  Monitoring Plan XE "Monitoring Plan"  is available from a link in the right side screen that you may copy and paste, with appropriate modifications. Enter you answer and click on the "OK" button.

Question 24.2 asks you to select all of the sources of information that you plan to use to support whether or not your objectives will have been met. Click on the link in the right side screen to see the pre-formatted text that will be entered. Only sources of information that you select will be entered into the pre-formatted text. Click on all of the sources of information that apply and click on the "OK" button.


Question 24.3 asks if you will perform statistical analysis XE "statistical analysis"  on any of the data. Select “Yes” and click on the "OK" button.

Question 24.3A asks for a summary of which data will be statistically analyzed and what types of statistical analysis XE "statistical analysis"  will be applied. Click on the link in the right side screen to see an example that may be copied and pasted, with appropriate modifications, in the space provided for your answer and click on the "OK" button.


Question 24.4 asks if you will include tables and/or charts to present some of the data. Select “Yes” and click on the "OK" button.


Question 24.1.1 asks for a description of which data will be presented in tables and/or charts. You may enter your own description (remember the SWAMP Advisor automatically generated tables for Elements 7, 12, 13, 14 and 16) or click on the link in the right side screen to see an example that may be copied and pasted, with appropriate modifications, in the space provided for your answer and click on the "OK" button.


Question 24.5 asks for a description of how limitations in data use XE "limitations in data use"  (which may occur) will be presented to data users. Click on the link in the right side screen to see an example that may be copied and pasted, with appropriate modifications, in the space provided for your answer and click on the "OK" button.


Question 24.6 asks for a description of how the data will be used in the context of various SWAMP components, including the SWAMP Information Management System XE "Information Management System" . Click on the link in the right side screen to see an example that may be copied and pasted, with appropriate modifications, in the space provided for your answer and click on the "OK" button.

Question 24.7 asks if additional evaluations will be used to determine whether the data will meet the project’s objectives. Select “No” and click on the "OK" button.

Question 24.8 asks for the name of the person who will be responsible for evaluating the data with respect to whether or not it supports meeting the project’s objectives. Enter the person’s name and click on the "OK" button.

Question 24.9 alerts you to the fact that you are finished entering information into Element 24 XE "Element 24" . Select “Yes” and click on the "OK" button to review your draft answers.


When you have completed your review of the displayed draft information then the next question asks if you want to save the draft text that you just reviewed to a “Rich Text Format XE "Rich Text Format" ” (RTF XE "RTF" ) file. Select “Yes” and click on the “OK” button. As soon as you click the “OK” button the SWAMP Advisor will compile your answers into a correctly formatted document for Element 23 and send it to your browser XE "browser" . If you do not see this happen then check Section 1.1 for solutions to the problem. Possible problems include your browser not having the tool bar options tab checked to download documents, a pop-up blocker XE "pop-up blocker"  not being deactivated, a security system such as in Internet Explorer’s Version 7 XE "Internet Explorer’s Version 7"  blocking the file from view, etc.


Click on the “File” tab in the MS Word file, select “Save As” and name this file, “24-QAPP.rtf” so that it will be saved to the file folder that you have created for your QAPP files.


After the file has been saved then that completes the work with Element 24 XE "Element 24" .


6.0 Glossary


Unless otherwise noted, the following definitions are from the Environmental Protection Agency’s Glossary of Quality-Related Terms: http://www.epa.gov/quality/glossary.htm

		Accuracy

		The closeness or agreement of the observed value or test response to the true or acceptable reference value or the test response from a reference method. It is influenced by both random error (precision) and systematic error (bias). The terms “bias” and “precision” are often used in lieu of “accuracy”.






		Analytical Batch*

		A group of 20 or fewer samples and associated quality control that are processed by the same instrument within a 24-hour period (unless otherwise specified by method). An analytical batch may comprise multiple sample batches.






		Analytical Run*

		The quantification of a single discrete sample or its associated quality control. 






		Assessment

		A general evaluation process used to evaluate the performance, effectiveness and processes of a management and/or technical system.






		Batch

		The collection of samples of the same group which is to be analyzed in one test run or inspected together within a specific time limit and traceable as a unit.






		Bias

		The constant or systematic distortion of a measurement process that manifests itself as a persistent positive or negative deviation from the known or true value. This can result from improper data collection, poorly calibrated analytical or sampling equipment, or limitations or errors in analytical methods and techniques.






		Blank

		A specimen that is intended to contain none of the analytes of interest and which is subjected to the usual analytical or measurement process to establish a zero baseline or background value. 






		Calibration

		A comparison of a measurement standard, instrument, or item with one having higher accuracy to detect, quantify, and record any inaccuracy or variation; the process by which an instrument setting is adjusted based on response to a standard to eliminate the inaccuracy.






		Calibration Standard

		Reference solution of known value used to correct an instrument reading.






		Comparability

		A measure of the confidence with which one data set, element, or method can be considered as similar to another. 






		Completeness

		A measure of the amount of valid data obtained from a measurement system.






		Continuing Calibration Verification*

		A periodic standard used to assess instrument drift between calibrations.






		Control Limit

		The variation in a process data set expressed as plus/minus standard deviations from the mean, generally placed on a chart to indicate the upper and lower acceptable ranges of process data and to judge whether the process is in or out of statistical limitations.






		Corrective Action

		Any measures taken to rectify conditions adverse to quality and/or to eliminate the causes of an existing nonconformity, defect, or other undesirable situation in order to prevent reoccurrence.






		Data Quality Objectives

		Qualitative and quantitative statements derived from the DQO Planning Process that clarify the purpose of the study, define the most appropriate type of information to collect, determine the most appropriate conditions from which to collect that information, and specify tolerable levels of potential decision errors.






		Data Validation

		An analyte- and sample-specific process that evaluates the information after the verification process (i.e., determination of method, procedural, or contractual compliance) to determine analytical quality and any limitations.






		Data Verification

		The process of evaluating the completeness, correctness, and conformance/compliance of a specific information set against the method, procedural, or contractual specifications for that activity.






		Drift*

		The directional deviation in instrument response from its set or reference value over a period of time.






		Equipment Blank

		An aliquot of reagent water that is subjected in the laboratory to all aspects of sample collection and analysis, including contact with all sampling devices and apparatus. The purpose of the equipment blank is to determine if the sampling devices and apparatus for sample collection have been adequately cleaned before they are shipped to the field site. An acceptable equipment blank must be achieved before the sampling devices and apparatus are used for sample collection.






		Field Blank

		A clean analyte-free sample which is carried to the sampling site and then exposed to sampling conditions, returned to the laboratory, and treated as an environmental sample. This blank is used to provide information about contaminants that may be introduced during sample collection, storage, and transport.


 



		Field Duplicate 


(Co-located)

		An independent specimen collected from the same point in time and space as the previous specimen.






		Field Duplicate (Subsample)

		A test specimen that is homogenized before being divided into two or more portions with the same laboratory analyzing all portions.






		Field Measurements

		Those activities associated with performing analyses or measurements in the habitat being examined.






		Holding Time*

		The period of time a sample may be stored following collection, preservation, extraction, or analysis. While exceeding the holding time does not necessarily negate the veracity of analytical results, it causes the qualification of any data not meeting all of the specified acceptance criteria.






		Indicators

		Items, elements, or measures used to determine or identify a basic condition or how well a process or program is meeting its objectives.






		Intercomparison

		An exercise in which samples are prepared and split by a reference laboratory, then analyzed by one or more testing laboratories and the reference laboratory. The


intercomparison, with a reputable laboratory as the reference laboratory, serves as the best test of the precision and accuracy of the analyses at natural environmental levels.






		Interference

		An element, compound, or other matrix effect present in a sample which disturbs the detection of a target analyte leading to inaccurate concentration results for the target analyte.






		Internal Standard

		Pure analyte(s) added to a sample, extract, or standard solution in known amount(s) and used to measure the relative responses of other method analytes that are components of the same sample or solution. The internal standard must be an analyte that is not a sample component.






		Laboratory Blank

		An aliquot of reagent water that is treated exactly as a sample including exposure to all glassware, equipment, solvents, reagents, internal standards, and surrogates that are used with samples. The laboratory blank is used to determine if method analytes or interferences are present in the laboratory environment, the reagents, or the apparatus.






		Laboratory Duplicate

		Two or more representative portions taken from one homogeneous sample by the analyst and analyzed in the same testing facility.






		Laboratory Control Sample

		A specimen of known composition prepared using contaminant-free reagent water, or an inert solid, that is spiked with the analyte of interest at the midpoint of the calibration curve or at the level of concern; and then analyzed using the same preparation, reagents, and analytical methods employed for regular specimens and at the intervals set in the Quality Assurance Project Plan.






		Matrix

		The material of which the sample is composed or the substrate containing the analyte of interest, such as drinking water, waste water, air, soil/sediment, biological material, etc. Also called medium or media.






		Matrix Spike

		A test specimen prepared by adding a known concentration of the target analyte to a specified amount of a specific homogenized specimen where an estimate of the target concentration is available and subjected to the entire analytical protocol.






		Matrix Spike Duplicate

		A sample prepared simultaneously as a split with the matrix spike sample with each specimen being spiked with identical, known concentrations of targeted analyte.






		Measurement Quality Objectives

		The individual performance or acceptance goals for the individual Data Quality Indicators such as precision or bias.






		Method

		A procedure, technique, or tool for performing a scientific activity.






		Method Blank

		A blank prepared to represent the sample matrix as closely as possible and analyzed exactly like the calibration standards, samples, and quality control (QC) samples. Results of method blanks provide an estimate of the within-batch variability of the blank response and an indication of bias introduced by the analytical procedure.






		Minimum Level

		The lowest level at which the entire analytical system must give a recognizable signal and acceptable calibration point for the analyte. It is equivalent to the concentration of the lowest calibration standard, assuming that all method-specified sample weights, volumes, and cleanup procedures have been employed.






		Parameter

		A statistical quantity, usually unknown, such as a mean or a standard deviation, which characterizes a population or defines a system. 






		Performance Based Measurement System 

		 A set of processes wherein the data needs, mandates, or limitations of a program or project are specified and serve as criteria for selecting appropriate methods to meet those needs in a cost-effective manner.






		Precision

		A measure of mutual agreement between two or more individual measurements of the same property, obtained under similar conditions.






		Quality Assurance

		An integrated system of management activities (planning, implementation, assessment, reporting, and quality improvement) that focuses on providing confidence in the data or product by ensuring that it is of the type and worth needed and expected by the client.








		Quality Control

		The overall system of technical activities that measures the attributes and performance of a process, item, or service against defined standards to verify that they meet the stated requirements established by the customer; operational techniques and activities that are used to fulfill requirements.






		Quality Assurance Officer

		The individual designated within an organization having management oversight and responsibilities for planning, documenting, coordinating, and assessing the system effectiveness for ensuring the value of the work.






		QAPP

		A document that describes the intended technical activities and project procedures that will be implemented to ensure that the results of the work to be performed will satisfy the stated performance or acceptance criteria. The amount of information presented and the planned activities to ensure the value of the work will vary according the type of study and the intended use of the data.






		QMP

		A document that describes an organization’s system in terms of its organizational structure, policy and procedures, staff functional responsibilities, lines of authority, and interfaces for those planning, implementing, documenting, and assessing all activities conducted.






		Sample Batch

		Twenty or fewer field samples prepared and analyzed with a common set of QC samples.






		Sensitivity 

		The capability of a method or instrument to discriminate between measurement responses representing different levels of a variable of interest. 






		Spike

		A known quantity of an analyte added to a sample for the purpose of determining recovery or efficiency (analyst spikes), or for quality control (blind spikes).






		Split 

		Two or more representative portions taken from one specimen in the field or in the laboratory and analyzed by different analysts, methods, or laboratories. 








		Standard Deviation

		The measure of the dispersion or imprecision of a series of accepted results around the average, equal to the square root of the variance.






		Standard Operating Procedure

		A written document that details the method for an operation, analysis, or action with thoroughly prescribed techniques and steps and that is officially approved as the method for performing certain routine or repetitive tasks. 






		Surrogate

		A pure substance with properties that mimics the analyte of interest (organics only) and which is unlikely to be found in environmental samples. It is added into a sample before sample preparation.






		Travel Blank*

		Analyte-free water placed in the same type of container as its associated field samples. It may be pre-preserved prior to shipment, but is not opened during the sample collection. Consequently, it helps isolate contamination associated with sample transport.
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SWAMP: Required by AB 982

		Comprehensive (surface water)

		Coordinate all Board ambient water quality monitoring

		High quality data (Quality Assurance)

		Comparable data

		Accessible





The Surface Water Ambient Monitoring Program, SWAMP, was initiated in FY00-01 in response to AB 982, which directed the Water Boards to design and implement a comprehensive water quality monitoring program.



The legislature asked that the program be comprehensive—addressing all waterbodies and all beneficial uses.



They asked that all the ambient water quality data collected by the Water Boards be coordinated, of high quality, comparable, and easily accessible to the public.









Meet Clean Water Act Objectives

		What is the overall quality of California’s surface water?

		To what extent surface water is changing over time?

		What are the problem areas and areas needing protection?

		What level of protection is needed?

		How effective are clean water projects and programs?





The federal Clean Water Act give the State and territories the primary responsibility for implementing programs to protect and restore water quality.



To meet those CWA requirements and comprhensive information on the status of benefical uses of California’s surface waters, The State Water Resources Control Board and Regional Boards introduced SWAMP in 2001.



To meet CWA objective SWAMP should answer these questions.









Elements of SWAMP

		Monitoring Program Strategy

		Monitoring Objectives

		Monitoring Design

		Core Indicators of Water Quality

		Quality Assurance

		Data Management

		Data Analysis/Assessment

		Reporting

		Programmatic Evaluation

		General Support and Infrastructure

		Citizens Monitoring





To achieve these objectives SWAMP developed, and are implementing, a 10 year SWAMP Implementation Strategy consistent with new federal guidance on states monitoring and assessment programs.  EPA region 9 has accepted the strategy.



It contains the 10 elements necessary for a scientifically-based program.  Although the strategy was not finalized until this year, staff began implementing the elements of the strategy in 2001.











State & Regional Monitoring Components







		Vary in scale of questions, objectives and design



		State program: 

		Asks broad questions:

		What % of state’s waterbodies are healthy ?

		Uses of program

		Environmental Protection Indicators for California (EPIC)

		305b report 

		Legislative reports



		Regional programs’ objectives and design are more specific

		Are specific waterbodies meeting WQ standards?

		303d list

		Are specific management/restoration efforts successful ?

		







At the scale of the state we ask big picture questions like what percent of our waterbodies support a healthy assemblage of aquatic life.  Is water quality in California getting better or worse?  We need this information for our EPIC indicators and 305(b) Water Quality Assessment Report.  



Equally important are the questions focused at the smaller regional scale.  Are specific waterbodies meeting water quality standards?  Are our TMDLs effective









Current Statewide Monitoring

		Perennial Stream Assessment  (bioassessment/benthic macroinvertebrate for aquatic life use)

		Lakes and reservoirs monitoring (Bioaccumulation study for fishable beneficial use)

		Integrator sites (long-term monitoring)





These monitoring are very limited as compared to waterbody types California has and the benefical uses of each water body.



Some beneficial uses such as drinkable, swimmable water, irrigated etc are not covered.











Elements of SWAMP

		Monitoring Program Strategy

		Monitoring Design

		Monitoring Objectives

		Core Indicators of Water Quality

		Quality Assurance

		Data Management

		Data Analysis/Assessment

		Reporting

		Programmatic Evaluation

		General Support and Infrastructure





The SWAMP Advisor was developed to help users meet Quality Assurance of the SWAMP element.











SWAMP Advisor

		QA has several components

		Quality Assurance Project Plan (QAPP) is just one of them.

		QAPP is required for all data collection efforts conducted by SWAMP and SWAMP and State funded projects.

		QAPP document is the planning, implementation and assessment procedures for a particular project

		SWAMP Advisor is a tool for QA

		SWAMP Advisor helps users to develop QAPP in more efficient and consistent manner
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California’s Surface Water Ambient Monitoring Program

Quality Assurance and 

Quality Control Tools

Will Hagan

Quality Assurance Research Group
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Data Quality Objectives

Examples:



		1) To determine whether methylmercury concentrations in catfish and bass tissue exceed the numeric objective of 0.23 mg/kg in selected sites



		2) To determine whether methylmercury concentrations in water exceed the numeric objective of 0.14 ng/L in selected sites





What do these objectives require of the project’s precision, accuracy, representativeness, comparability, completeness, and sensitivity (PARCCS)?
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Project Priorities



A project might emphasize:



		PRECISION if the sample matrix is highly variable 

		ACCURACY if an action limit is specified

		REPRESENTATIVENESS if a sampling site is highly variable

		COMPARABILITY if it has many data sources (more later)

		COMPLETENESS if there is significant potential for data loss

		SENSITIVITY if there is an ultra-trace level of target analyte

























		Indicator		Quality Control

		Precision		Laboratory Duplicates, Matrix Spike Duplicates, Field Duplicates

		Accuracy		Reference Materials, Matrix Spikes, Matrix Spike Duplicates, Continuing Calibration Verification Standards

		Representativeness		Data Quality Assessment

		Comparability		Proficiency Tests/Intercomparisons

		Completeness		Data Verification

		Sensitivity		Detection Studies, Instrument Calibration
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		Quality Control		Frequency		Control Limits

		Equipment Blanks
Bottle Blanks		Random statistical testing		< ML for Target Analyte

		Field Blanks		1 per field event		< ML for Target Analyte

		Field Duplicates		1 per 20 samples collected		RPD < 25%

		Calibration Curve		1 per analytical day		r > 0.995

		Continuing Calibration Verification		After initial calibration and after every 10 samples		80-120% recovery

		Method Blanks		3 blanks per set of 20 field samples		< ML for Target Analyte

		Reference Materials		1 per set of 20 field samples		80-120% recovery

		Laboratory Duplicate		1 per set of 20 field samples		RPD < 25%

		Matrix Spike		1 per set of 20 field samples		80-120% recovery

		Matrix Spike Duplicate		1 per set of 20 field samples		80-120% recovery; RPD < 25%
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Previous SWAMP Quality Assurance Plan

Background

		Released December 2002 

		Written by Max Puckett (DFG) for the State Board



Issues

		Unrecognized Scope and Format

		Many Dated Attachments

		Project-Specific Material

		Five Years Old
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New SWAMP Quality Assurance Plan

Updates

		EPA Scope and Format

		Removal of Unnecessary Attachments 

		Removal of Project-Specific Material

		References to State Board Quality Management Plan

		Extensive Feedback Process



Approved and Available Online
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Quality Assurance Project Plan

Group A: Project Management

		Nine Elements



Group B: Data Generation and Acquisition

		Ten Elements



Group C: Assessment and Oversight

		Two Elements



Group D: Data Validation and Usability

		Three Elements
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Group A: Project Management

Administrative 

		Organizational and Contact Information

		Roles and Responsibilities

		Training and Documentation Policies



Planning

		Quality Objectives

		Project Background and Description



Useful Documents

		State Board Quality Management Plan

		Human Resources Documents
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Group B: Data Generation and Acquisition

Technical Information

		Sampling 

		Analysis

		Instruments and Equipment

		Data Management



Useful Documents

		Field Sampling Plan

		Project Assessment and Evaluation Plan

		Methods/Standard Operating Procedures

		Contractor Quality Documents

		Manufacturer Specifications
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Group C: Assessment and Oversight



Checks and Balances

		Evaluation and Corrective Action

		Feedback Processes

		Lines of Communication



Useful Documents

		State Board Quality Management Plan

		Methods/Standard Operating Procedures

		Contractor Quality Documents
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Group D: Data Validation and Usability



Data Use

		Data Review

		Data Presentation



Useful Documents

		State Board Quality Management Plan

		Methods/Standard Operating Procedures
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Useful Documents

		State Board Quality Management Plan

		SWAMP Quality Assurance Program Plan

		Associated QAPPs

		Contracts

		Proposals/Requests for Proposals

		Field Sampling Plans

		Project Assessment and Evaluation Plans

		Laboratory/Field Quality Manuals

		Standard Operating Procedures/Methods

		Human Resources Documents
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Useful Tools

EPA Quality System Document: Guidance for

Quality Assurance Project Plans (EPA QA/G-5)

		Element-specific Guidelines on Scope and Format 



SWAMP Advisor

		Interactive Online Expert System





SWAMP Quality Assurance Program Plan

		SWAMP-Specific Project Guidelines
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The Quality Assurance Research Group 

at

Moss Landing Marine Laboratories





        Shelly Fank: sfank@mlml.calstate.edu



      Will Hagan: whagan@mlml.calstate.edu



Jennifer Parker: jparker@mlml.calstate.edu



Beverly van Buuren: bvanbuuren@mlml.calstate.edu



Amara Vandervort: avandervort@mlml.calstate.edu



Eric von der Geest: evondergeest@mlml.calstate.edu
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California’s Surface Water Ambient Monitoring Program

SWAMP Advisor Training Agenda







Add Text Here



 

 

Purpose:

Become familiar with SWAMP Advisor tool and test the tool

 

Desired Outcome:

Identify issues in SWAMP Advisor and list identified issues for updating SWAMP Advisor.







Introductions and Announcements

 Time:  10 Minutes 

From: 9:00-9:10 A.M

Introduction of Training Course participants &

Announcements 

 









Overview of SWAMP 

 

Presenter:    Dawit Tadesse

Time: 15 Min

From:  9:10-9:25 a.m.

 

Overview of the SWAMP program

 

 







SWAMP Quality Assurance and QAPPs 

 

Presenter:    Will Hagan

Time: 30 Min; 

From:  9:25 to 9:55 A.M.  

Purpose:

Overview of the new SWAMP Quality Assurance Program Plan (QAPrP) and QAPP requirements

Desired Outcome:

Familiarity with QAPrP and QAPP







SWAMP Advisor

 Presenter:    Larry Keith

Advantages and Limitations of Expert Knowledge Systems & the SWAMP Advisor 

 Time:  15 Min; From:  9:55 to 10:10 a.m.

Purpose:Introduce Concept of an “expert” system and SWAMP Advisor

Desired Outcome:Familiarity with expert systems and SWAMP Advisor advantages and limitation

 What is the SWAMP Advisor does and how does it work

 Time:  20 Min; From:  10:10 to 10:30 a.m.  

 Purpose:Introduce the functionality of SWAMP Advisor

Desired Outcome:Understand what to expect from SWAMP Advisor







Break

 

15 Min; 10:30 to 10:45 a.m.







Continued

How to produce qapp document files   

Time:  15 Min; From: 10:45 to 11:00 am  

Purpose:Introduce how the SWAMP Advisor produces QAPP document files

Desired Outcome:Understand how to save and name QAPP document files

 How to produce tables using swamp advisor

 Time 15 Min; From: 11:00 to 11:15 a.m.  

Purpose:Introduce how the SWAMP Advisor produces comma-delimited tables

Desired Outcome: Understand how to make ‘regular’ tables from comma-delimited data



 







Continued

How to produce a master qapp document with a table of contents

Time 15 Min; From: 11:15 to 11:30 a.m. 

Purpose: Introduce how the SWAMP Advisor compiles individual document files

Desired Outcome: Understand how to use Word Macros to make a master QAPP document

How to incorporate multiple study questions in a qapp

Time 30 Min; From: 11:30 to 12:00 PM  

Purpose:Introduce the concept of multiple study questions in large complex projects

Desired Outcome:Understand how to integrate data from projects with multiple analytical  levels







Lunch



60 Min; 12:00 to 1:00 p.m.









Hands on





1:00 – 3:30 p.m.  Examples and individual trials using the swamp advisor





3:30 – 4:00  Discussion & evaluation
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